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Notes on Installation and Usage 
These notes should be considered more up-to-date than the information in other 
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Notes on Installation 

The installation notes contain important information that you will require in order to 
install STEP 7 V5.4 including SP3 Read these notes before installing the software. 



1 Contents of the Consignment 

The two CDs in the content of consignment contain a complete version of STEP 7 
V5.4 including SP3. 

This version is in 5 languages and can be run using the operating systems listed in 
section 3.1. 

STEP 7 V5.4 including SP3 is currently supplied on two CDs "STEP 7 V5.4 including 
SP3 CD1/2" and "STEP 7 V5.4 including SP3 CD2/2" in the contents of consignment 
with a floating, upgrade, rental or trial license: 

STEP 7 V5.4 including SP3 (Floating License) 
Order number: 6ES7810-4CC08-0YA5 

The following items are included in this package: 

• 2 CDs STEP 7 (CD1/2 and CD2/2) 

• 1 License key USB stick 

• 1 Certificate of license 

• 1 Product information 

STEP 7 V5.4 including SP3 (Floating License) (V3/V4/V5.x > V5.4)  
Order number: 6ES7810-4CC08-0YE5 

The following items are included in this package: 

• 2 CDs STEP 7 (CD1/2 and CD2/2) 

• 1 License key USB stick 

• 1 Certificate of license 

• 2 Product information 

STEP 7 V5.4 Rental License (50h) including SP3 
Order number: 6ES7810-4CC08-0YA6 

The following items are included in this package: 

• 2 CDs STEP 7 (CD1/2 and CD2/2) 

• License key USB stick  

• 1 Certificate of license 

• 1 Product information 

STEP 7 V5.4 Trial License (14 days) including SP3 
Order number: 6ES7810-4CC08-0YA7 

The following items are included in this package: 

• 2 CDs STEP 7 (CD1/2 and CD2/2) 



Contents of the STEP 7 CDs 
CD1/2 (Installation CD) 

• STEP 7 V5.4 including SP3 

• Converter for the conversion of TI405 and TI 505 programs 

• Automation License Manager  

• License-free 5-language version of the Acrobat Reader with which you can read 
and print the supplied manuals 

 

CD2/2 

• Product information: "What's New"  

• Product information: "New Modules" 

• Product information: "Central Installation" 

• Manual: "Getting Started: Working with STEP 7" 

• Manual: "Programming with STEP 7" 

• Manual: "Configuring Hardware and Communication Connections with STEP 7" 

• Manual: "System Modification in RUN Mode via CiR" 

• Manual: "Automation System S7-400H - Fault-Tolerant Systems" 

• Manuals: "NCM S7" 

• Manual: "From S5 to S7" 

• Manual: "Ladder Logic (LAD) for S7-300/400" 

• Manual: "Statement List (STL) for S7-300/400" 

• Manual: "Function Block Diagram (FBD) for S7-300/400" 

• Manual: "Standard and System Functions for S7-300/400" 

• Manual: "Standard and System Functions for TI STEP 7 Converter" 

• Manual: "PID Control" 

• Manual: "PID Temperature Control" 

• Compatibility list 

• SIMATIC iMap STEP 7 Add-on 

• Description of the Command Interface  

 

The manuals are available in an installable form on CD1/2 and are optionally 
available on your computer after STEP 7 has been installed. If you do not install the 
manuals, you can also view at any time on CD2/2. 



2 Hardware Requirements 

In order to work with the STEP 7 V5.4 including SP3 software, you need a 
programming device or a PC with the following minimum requirements for processor 
speed/performance, RAM and graphics capability: 

 
Operating System Minimum Requirements for: 
 Processor RAM Graphics 

MS Windows 2000 
Professional 

600MHz 512 MB *) XGA 1024x768  
16-bit color depth 

MS Windows XP 
Professional 

600MHz 512 MB *) XGA 1024x768  
16-bit color depth 

MS Windows Server 
2003 

2.4 GHz 1 GB XGA 1024x768  
16-bit color depth 

MS Windows Vista 
Business 

1 GHz 1GB **) XGA 1024x768  
16-bit color depth 

MS Windows Vista 
Ultimate 

1 GHz 1GB **) XGA 1024x768  
16-bit color depth 

MS Windows Vista 
Enterprise 

1 GHz 1GB **) XGA 1024x768  
16-bit color depth 

*) At least 1 GB RAM is recommended 
**) At least 2 GB RAM is recommended 

 

Use a programming device or PC with the latest performance capabilities if you are 
editing extensive STEP 7 projects or working with hardware configurations 
containing several hundred modules (CPUs, slaves, I/O devices, etc.). 

In addition, you will need an external prommer for SIMATIC memory cards / MMC if 
you are using a PC and want to save your user programs to EPROMs and a 
SIMATIC NET interface if you want to use online functions to the PLC system with 
your personal computer. 

Additional information on Windows Vista: 

The “Aero Glass Style” can only be used with a high-performance graphic adapter. It 
requires: 

• DirectX9 capability 

• 128 MB separate graphic memory 

• The performance of the graphics system architecture can have a substantial 
affect on the performance of STEP 7. 



3 Software Requirements 

3.1 Operating Environment 

Operating systems 
STEP 7 V5.4 including SP3 is a 32-bit application that is released for the following 
operating systems: 

 
Operating System Service Pack 

MS Windows 2000 Professional SP4 
MS Windows XP Professional SP2 

 

• MS Windows Server 2003 SP2 Standard Edition with or without R2 as 
workstation  
computer (exception: SIMATIC M7, see also, instructions in Section 6.18) 

• MS Windows Vista 32 Bit Ultimate and Business 

 

You can find information about the operating systems on the Internet at Microsoft. 

 

STEP 7 V5.4 including SP3 will not run in: 

• MS Windows 3.1 

• MS Windows for Workgroups 3.11 

• MS Windows XP Home 

• MS Windows Vista Home Basic and Premium 

The operating systems MS Windows 95, MS Windows 98SE, MS Windows 
Millennium and MS Windows NT 4.0 are no longer supported since STEP 7 V5.3.  

Important additional information: 
An operating system update from MS Windows XP to MS Windows Vista is not 
allowed or possible for existing STEP 7 installation. 

Internet Explorer 
All operating systems must be using MS Internet Explorer 6.0 (or higher).  

User rights 
Regarding user rights as of STEP 7 V5.4 including SP3, please observe the 
following: 



To be able to work with STEP 7, you must have logged on at least as the user (not as 
a guest).  

You need administrator rights to be able to install the STEP 7 software and HSPs, 
set up user groups and change the settings using "Set PG/PC Interface" function. 

When using optional packages please observe the rights required by the respective 
optional packages. 

If projects are saved on NTFS drives, the users must be granted full access here. 
This also applies to the folders with the HSP updates (default: C:/HWUPDATES). 
Access within the standard project directory S7PROJ is automatically granted to all 
users. 

 
 Note: 

The executability under user rights is only enabled for STEP 7 itself. Operation under
user rights for optional packages is not guaranteed. Administrator or primary user 
rights may be required here. 

After installing / uninstalling new hardware, the computer must be run at least once 
under administrator rights.  

 

File systems 
STEP 7 achieves a slightly lower performance when operating on a MS Windows NT 
file system (NTFS) as opposed to a FAT file system. 

Hibernation mode 
Shifting to hibernation mode is generally allowed by STEP 7. However, hibernation 
must not be triggered if online connections are open or projects are being accessed 
by STEP 7 applications via a network.  

In such case, online connections could be unintentionally terminated, and open 
projects on networks may experience data loss. 

For these reasons, the energy options for the operating system in the Windows 
Control Panel should be set so that hibernation is not automatically triggered (by 
timer). Hibernation should not be triggered manually by the user in the cases 
mentioned above. 

3.2 Memory Requirements 

Memory requirements for STEP 7 
Depending on your installation requirements and the number of languages installed, 
STEP 7 V5.4 including SP3 requires between approx. 650 MB and 900 MB of 
memory on your hard disk. The exact value also depends on your operating system 
and on the file system used on your programming device/personal computer. 



MS Windows swap file 
The supported Windows operating systems also require additional free space on the 
hard disk (typically C:) for their swap files, depending on the memory configuration. 
You should keep at least double the value of the RAM free. (Example: If you have 
512 Mbytes of RAM, you will require another 1024 Mbytes of free space on the hard 
disk for the swap file after STEP 7 has been installed.) Depending on the size of the 
project, it may be necessary to have a larger swap file, for example, when copying an 
entire project (twice the size of the project on the hard drive in addition). If the free 
memory area for the swap file is too small, errors may occur (the program could 
possibly crash). Additional Windows applications which run parallel to STEP 7 (such 
as Microsoft Word) also require additional hard disk space for the swap file. 

In order to ensure that the required memory for the swap file is really available, the 
minimum size for the swap file should be set to the above value. This can be set in 
Windows (for example, Windows XP Professional) in the taskbar in Start > Settings 
> Control Panel (in System > Advanced > System Performance > Settings > 
Advanced). 

You must make certain that you have enough free memory on the drive where the 
project data are located. If there is not enough memory on the drive, the project data 
may be destroyed during an operation (for example, when compiling an STL source 
file into blocks). We also recommend that you do not store the project data on the 
same drive as the Windows swap file. 

3.3 Compatibility with Other Software Products 

Rational ClearCase 
STEP 7 projects must not be stored on ClearCase drives; that is, drives that are 
linked to a ClearCase View (MVFS). 

3.3.1 Network Settings when Using other Software Products  

If you are using other software products (for example, mail providers) on a 
programming device or PC with STEP 7, observe the additional notes on network 
settings in the section "Using Network Drives" (in Notes on Usage) in the second half 
of this README file. 

3.3.2 Interaction with an Installed S7 Fault-tolerant System 

The configuration of fault-tolerant systems (H system) is integrated as of STEP 7 
V5.3. If STEP 7 V5.4 including SP3 is installed on a PC on which the S7 H Systems 
add-on package is installed, this is removed. Do not install the “S7 H Systems” 
optional package again. It is no longer required. 

3.4 Online Documentation 

The online help in STEP 7 V5.4 including SP3 is split into two sections.  



You can find notes on the current context in the same way as with the standard 
Windows help. 

The general section of the online help is based on the HTML format.  

You can find more information on the structure of the documentation in Chapter 7 (in 
Notes on Usage) in the second half of this README file. 

3.5 Upgrading from an earlier STEP 7 version  

3.5.1 STEP 7 V5.4 Upgrade Including SP3 

To install the upgrade package, you must have a valid license for STEP 7 V3.x, V4.x, 
V5.0, V5.1, V5.2, or V5.3. 

 

Note 
Take into account that an upgrade may require the operating system to be 
replaced, because as of STEP 7 V5.3 older operating systems are no longer 
supported (refer to Chapter 3.1). Further information on the upgrade is contained in 
the product information.  

The existing authorization / license key with the AuthorsW / Automation License 
Manager program has to be saved to a floppy disk / USB stick before the operating 
system is replaced. 

 



4 Installation 

4.1 Installing STEP 7 V5.4 including SP3 

When installing STEP 7 V5.4 including SP3, you can overwrite existing installations 
of STEP 7 V5.1, V5.2, V5.3 or V5.4 whilst observing the authorized operating 
systems (refer to Chapter 3.1). You do not have to uninstall these STEP 7 versions 
and optional packages prior to the installation. However, you must uninstall older 
versions and their optional packages beforehand. 

In order to obtain the optimum display of the information during the Setup, you 
should set the color scheme in the control panel of your programming 
device/personal computer to at least 65536 colors. 

Before starting the Setup program, close all applications (such as Microsoft Word, 
etc.) and the "Control Panel" window, since you will need to restart Windows 
following the installation of STEP 7 V5.4 including SP3 so that all system variables 
can be entered completely. 

Insert the STEP 7 CD 1/2 in the drive. The setup program will guide you through the 
installation. The setup program starts automatically after the STEP 7 CD is inserted 
in the drive. If you have disabled this function on your computer, start the setup 
program by double-clicking the SETUP.EXE program in the root directory. 

In the component selection box, select the Acrobat Reader, STEP 7, the Automation 
License Manager, Acrobat Reader and any other components that you wish to 
install. 

If you would like to change the installation path suggested in the setup during the 
STEP 7 installation, please note that you cannot install it directly to a root directory 
(e.g. D:) on your computer. There has to be at least one higher-level folder such as 
"STEP7", for example, D:\STEP7. 

These components will then be installed and entries will be made in Microsoft 
Windows files. 

The following notes are intended to help you make the correct user entries required 
during the Setup program: 

• The drive on which you install your STEP 7 V5.4 including SP3 system can be 
selected freely. On some PCs/programming devices, you will not be able to 
select the drive via the selection list. In this case, simply enter the drive with its 
path in the appropriate input box (for example, "e:\Siemens/Step7"). Note that all 
STEP 7 optional packages must also be installed on this drive, so there must be 
sufficient space available (see the "Memory Requirements" 3.2). Avoid installing 
STEP 7 on a SUBST drive. 

• Before you use STEP 7 V5.4 including SP3, Windows must be restarted. Only 
then do all of the Microsoft Windows entries become active. If you do not restart 
Windows, STEP 7 V5.4 including SP3 cannot run properly and data may be lost. 
If the installation procedure is aborted, you will also need to restart Windows. 



• Refer to the tables in the S7KOMP_B.PDF file (the directory "Step7" following 
installation) for information on which versions of the optional packages can run 
with STEP 7 V5.4 including SP3 under the respective operating systems.  

• STEP 7 must not be installed in a directory the path of which includes characters 
that are not listed in the ASCII character set (refer to the section “Note on Using 
Foreign-Language Character Sets”). 

Contact your Siemens representative for more up-to-date information or check our 
website: http://www.ad.siemens.de/support. 

If the required version is not available on the computer, Acrobat Reader is 
automatically suggested for installation. 

 

Note 
STEP 7 registers itself in the system files of the MS Windows operating system. You 
cannot move or rename STEP 7 files or folders using Microsoft Windows utilities 
such as the Explorer or modify STEP 7 data in the Microsoft Windows registry. The 
program may no longer run properly after such modifications. 

 

4.2 License Key of STEP 7 V5.4 including SP3 

The license is provided on a USB stick instead of a floppy in new deliveries of STEP 
7 as of STEP 7 V5.4 SP3. 

Therefore, when transferring the license to the hard disk of your computer, select the 
source medium where the license is located accordingly, a floppy or USB stick. 

Before you can start working with STEP 7, you must transfer the license key to the 
computer. There are two ways of doing this: 

• While you are installing STEP 7, the Setup program displays a message if there 
is no suitable license key installed on your computer. You can then decide 
whether you want the license key to be installed by the “Setup” program or 
whether you want to install the license key manually at a later time using the 
“Automation License Manager” program.  

• If the license key cannot be installed during setup, continue the Setup program 
without installing the license key. Then boot the computer and install the license 
key using the taskbar in (for example, Windows XP Professional) 
SIMATIC\License Management\Automation License Manager 

To operate STEP 7 as of V5.3, you must make sure the Automation License 
Manager is installed.  

After the upgrade from V5.4 or V5.4 SP1 to V5.4 including SP3, the license key for 
V5.4 can continue to be used. 

 



Note 
The Automation License Manger prevents the authorizations/license keys from 
being installed on invalid drives or media such as RAM drives, diskettes or 
compressed drives (i.e. DBLSPACE). If the drive in a device is reported as being a 
"removable medium" and not, as usual, as a "hard drive", it will be treated as a CD, 
which means that no license key may be installed on it.  

In the case of compressed drives, you can install the authorization on the 
associated host drive.  

Read the notes on the Automation License Manager in the ALM-README.RTF file 
on the STEP 7 installation CD under "Automation License Manager\disk1\". 

Hidden files are stored in the folder "<Drive, on which the authorization/license key 
is installed>:\AX NF ZZ". These files and the folder must not be deleted, moved, or 
copied. They contain data required for the licensing of your software.  

If you do not adhere to these guidelines, the authorization/license key may be 
irretrievably lost. 

 

Note about using license keys correctly 
• The license stick must not be read-only. Since the license stick must be used 

without write protection, there is a danger that a virus could be transferred from 
the hard disk to the diskette. You should therefore run a virus check on your PC 
or programming device every time you install or remove a license key. 

• If you use a defragmentation program, which enables you to move fixed blocks 
of memory, only use this option once you have moved the license key from the 
hard disk back to the license diskette/stick. 

• When you install a license key, a cluster appears on the target drive marked with 
a special character. Some testing programs may show this cluster as 
"defective." Do not attempt to "repair" the cluster. 

• Do not forget to transfer the license key to the license diskette/stick before 
formatting, compressing, or restoring your hard disk or before installing a new 
operating system. 

• If a backup copy of your hard disk contains copies of license keys, there is a 
danger that these copies may overwrite the valid installed license keys when you 
restore your backup data to the hard disk, thereby destroying the valid license 
keys. To prevent a valid license key from being overwritten by a backup copy, 
you must remove all license keys before you make a backup copy or exclude the 
license keys from the backup. 

Using the trial license 
If there is no valid License Key installed for S7-SCL V5.3, SP3 a trial license key , 
which is supplied and installed with S7-SCL is used. This license key allows you to 
run S7-SCL for only fourteen days. The trial license is activated, following 
acknowledgment, at the first start of S7-SCL without a valid license key. 



4.3 Removing STEP 7 V5.4 including SP3 

 

Note 
Software products must be uninstalled according to Microsoft Windows 
conventions.  

Use the Microsoft Windows application "Add/Remove Programs" (for example, 
under MS Windows XP in the taskbar ...in ... > Settings > Control Panel > 
Add/Remove Programs) to remove your software package (for example, "STEP 
7").  

As an alternative, you can use the setup program to uninstall a program. 

 

If you uninstall an older version of STEP 7 in order to install STEP 7 V5.4 including 
SP3, you must first uninstall any existing optional packages for STEP 7 as well. 

4.4 Additional Notes on Installation 

4.4.1 Using a Wheel Mouse 

When using a wheel mouse, be sure that the driver supplied by the manufacturer is 
installed. If this is not the case, STEP 7 will not always support the wheel feature of 
the mouse. 

4.4.2 Notes on using Communication Cards in PCs/ PGs 

CP 5611/ CP 5611 onboard (SIMATIC NET PROFIBUS interface via 
PCI Bus) 
In order to use the CP 5611 card you require a PC or a programming device with 
PCI bus. You can then address SIMATIC stations via MPI or PROFIBUS (9.6 Kbps 
to 12 Mbps). 

If you install STEP 7 after the CP has been inserted in the computer, the Plug and 
Play mechanism enters the CP 5611 in the Device Manager of the Control 
Panel\System in "Other Devices". Therefore, the CP is sometimes not recognized 
when installing STEP 7. 

In such cases, remove the CP 5611 in the Device Manager after installing STEP 7 
and reboot your computer. 

Observe the notes in the online help under "Setting the PG/PC Interface." 

CP 5511 (SIMATIC NET PROFIBUS interface via PCMCIA) 
The card and socket services required to operate the card form part of MS 2000/XP. 
The CP 5511 has plug-and-play facilities, meaning that the card is recognized by 



MS Windows 2000/XP and is integrated automatically into the system, provided your 
PC/programming device has sufficient free resources (interrupt, address area).  

The CP 5511 cannot be operated in notebooks that are equipped with a PCMCIA 
controller of the type Omega Bridge II or TI 1130. 

 

Note 
The CP 551 does not support ACPI (Advanced Configuration and Power Interface) 
completely.  

The CP 5511 is not supported under MS Windows Server 2003 and MS Windows 
Vista. 

 

CP 5512 (SIMATIC NET PROFIBUS interface via PC card)  
A PC or a programming device with PC card slot is required to use the CP 5512. You 
can then address SIMATIC stations via MPI or PROFIBUS (9.6 Kbps to 12 Mbps). 

MPI-ISA Card/ MPI-ISA onboard 

The MPI-ISA card and the MPI-ISA onboard are no longer supported under 
MS Windows 2000 / XP, MS Windows Server 2003 and under MS Windows Vista. 

Hardnet modules 
If you use the Industrial Ethernet network card CP 1613 or the PROFIBUS cards 
CP 5613/14, you require the optional package SIMATIC NET PC additionally in a 
version compatible with STEP 7 V5.4 including SP3 (see Compatibility list 
S7KOMP_A.PDF in the installation directory "STEP7"). 

You require the SIMATIC-Net software as of V6.2 (CD 11/2003) to operate 
CP 5613_A2 and CP 5614_A2.  

General PC/programming device settings  

Commissioning plug-and-play compliant modules 
To commission the Plug-and-Play compliant modules (e.g. CP 5512 and CP 5611) in 
MS Windows 2000/XP/Server 2003/Vista, please proceed as follows: 

1. Install STEP 7. Close the dialog "Set PG/PC Interface" which appears at the end 
of the Setup without entering anything. 

2. Close MS Windows, shut down the PC and install the card. The CP 5512 can 
also be inserted in during operation. 

3. The communication module is installed automatically after the restart (or after 
CP 5512 has been inserted). 

4. Under Windows 2000, the message "New hardware found" is displayed. Confirm 
this message and all following dialogs (do not click on CANCEL). 

5. Under WinXP/Server2003, the Hardware Wizard is displayed. In the first dialog 
shown, select the option "No, not this time". Confirm all following dialogs (do not 
click on CANCEL). 



6. Then check the settings or select the desired interface configuration in "Set 
PG/PC Interface" (...> STEP 7>Set PG/PC Interface). 

Observe the information in the online help under "Set programming device/personal 
computer interface". 

When STEP 7 is installed on programming devices, the communication drivers are 
installed automatically and the default settings are accepted.  

Setting of interrupt and address 

MS Windows 2000/XP/Server 2003/Vista: 
The settings of address area and interrupt cannot be changed in MS Windows 2000, 
MS Windows XP, Server 2003 as well as Windows Vista. The assigned values can 
be viewed by doing the following: Open, for example, in MS Windows XP Start > 
Settings > Control Panel > Administrative Tools > Computer Management and 
then "System". In the Device Manager, you can view the values of individual 
modules. In System Information > Hardware Resources, you can view the 
reserved resources. 

In BIOS of the PC, certain interrupt and address area may be reserved for PCI 
components. Please consult your PC or BIOS manufacturer. 

Operating networks exclusively with passive nodes (slaves) 
Before you start working with your programming device / PC on a network to which 
only slaves are connected (passive nodes), you must activate the option "PG/PC is 
only master on the bus." Otherwise, your programming device / PC will remain 
inactive. To do this, proceed as follows: 

1. Start the application "Setting the PG/PC Interface" (for example, under 
MS Windows XP via Start > SIMATIC > STEP 7 > Setting the PG/PC 
Interface). 

2. Display the properties of the module parameter set used. 

3. Activate the option "PG/PC is only master on the bus" in the tabbed page 
displayed. 

4. Close the dialog box again. 

Once you have finished working on this network, you should de-activate the option. 
This protects the network from possible interruptions caused by plugging in the MPI 
cable while the interface on your programming device / PC is active. 



Notes on Usage (Release Notes) 

These notes should be considered more up-to-date than the information in manuals 
and online helps. 



5 New Features and Changes in the New 
Version 

What's new in comparison to version 5.3? 
For more information, read the RTF file "What's New" on your STEP 7 CD or refer to 
the corresponding section "What's New?" in the online help. You can call this topic 
from the contents page of the Help on STEP 7 (menu command Help > Contents). 

Additional changes: 
• The H Systems add-on package is no longer required with STEP 7 V 5.3. The 

functionality is integrated in STEP 7. 

• The NCM add-on package is not required. The functionality is integrated in 
STEP 7. 



6 Notes on Configuring and Operating the 
Software 

6.1 How STEP 7 Fulfills the IEC Standard 

The exact definition of compliance with the standard can be found in the 
NORM_TLB.RTF file in the subdirectory that you selected during setup.  

6.2 General Notes 

Special characters may not be used in file names, folder names, or project names. 

You should not use diskettes as the work medium for project data because of 
storage space limitations and slow access time. 

The contents of the windows are not automatically updated (for example, the 
window contents in the SIMATIC Manager are not always up-to-date after an 
interruption of the Online connection). If in doubt, use the F5 key to refresh the 
contents of the active window. 

Screen savers 
When using a screen saver, you should note that the additional processing required 
takes up CPU time and this can lead to the system being overloaded. Some screen 
savers are known to prevent the release of main memory components. This leads to 
a continuous reduction in the usable main memory. 

Using virus scanners  
The following virus scanners have been tested with STEP 7 V5.4 including SP3 for 
compatibility: 

• Symantec Antivirus Corporate Edition 9.0 

• Trend Micro OfficeScan Client 8.0 

The virus scanners listed above can generally be used in the standard setting.  

User data should not be stored in STEP 7 project directories (for example, Microsoft 
Word documents), since when you delete a STEP 7 project from the SIMATIC 
Manager, these user data are also permanently deleted. You cannot use the "Undo" 
function to retrieve deleted data from the Windows Recycle Bin. 

Moving (with drag-and-drop) selected STEP 7 objects (such as blocks) to MS 
Windows objects (such as the Recycle Bin) is not possible even if the "unavailable" 
cursor does not appear. 

SUBST drives should not be used for storing STEP 7 or your project. 



PC and TS adapters 
If the connection is interrupted or lost when using PC or TS adapters for 
communication connections, check the power management preferences on your 
computer.  

Downloading configuration data 
When you configure the complete SIMATIC hardware, the configuration data are 
stored automatically in the offline database. The data are stored in the "System 
Data" folder under the user program (described as "Blocks"). If this user program is 
downloaded to a CPU with its configuration data, the data in the CPU become 
effective immediately, meaning they may change the existing set values (for 
example, a new MPI address). For safety reasons, it is recommended that the 
complete user program with the configuration data should only be downloaded when 
absolutely necessary (such as loading onto memory cards). 

Downloading a configuration also containing configuration data for a CP should be 
done via the MPI interface of the CPU. Downloading the configuration data to the 
CPU via the CP can result in the connection being canceled. 

Handling system data 
It is not a good idea to copy these to another module. This folder contains the 
configuration data of the hardware configuration and the network/communication 
configuration. The network/communication configuration data are data that are not 
just relevant to one station/module. In the same way, when loading a SIMATIC 
configuration from the PLC to a programming device/PC using the "Configuring 
Hardware" application, you only load the hardware configuration data to the system 
data folder. 

Flash file driver for S7-EPROM 
If you select the flash file driver as well as the S7 EPROM driver in the Control Panel 
under "Memory Card Parameter Assignment," this driver will be allocated another 
drive letter in the system following installation.  

In Win2000/XP/Server 2003/Vista the drive can be chosen in a selection box. 

'Remote Desktop' and 'Quick User Change' 
STEP 7 does not support the "Remote Desktop" or the "Quick User Change" 
Windows XP Professional, and MS Windows Server 2003 and MS Windows Vista. 
However, if you wish to use these operating system properties with STEP 7, please 
note the following: STEP 7 applications can only be started in one session. If a 
STEP 7 application is started in a session via "Remote Desktop" or "Quick User 
Change", no more STEP 7 applications can be started in other sessions. Only one 
user can work with STEP 7 applications on a computer. 

When using optional software packages, please note that can only be called up and 
operated by one user - otherwise this could cause mutual influencing. 



6.3 Using Network Drives 

Storing projects on a network 
If the network connection is interrupted while you are working with 
projects/multiprojects on network servers and you then receive a message that a 
project/server is not available, exit all affected projects/multiprojects without saving 
and then restore the connection to the server before you continue working with the 
projects.  

To access network drives, it is also necessary that the PCs are connected with their 
names and not their IP addresses. If the name resolution cannot be performed 
automatically by broadcasts and no service is used for resolving names, it can be 
performed by a reference to the PCs in the file <WINDOWs>system32\\LMHOST. If 
no LMHOST file is available, it can be generated by copying LMHOST.SAM. The file 
contains an example of the syntax. 

In order to access the network drives, ensure that the editor has the necessary 
read/write permissions for the network as well as the folders it contains. In a 
multi-user environment, the logged on user must also have share rights for the 
network as well as the folders it contains. 

6.4 Multi-user Operation 

Release of shares 
If, in MS Windows XP/Server 2003/Vista, shares of a NTFS partition are released, 
the users who are to have access to this share should be entered in two places. 
Select the menu command "Sharing and Security", and enter the users in both the 
"Sharing" tab as well as the "Security" tab. 

Please also observe the notes in the following section on "Multiprojects". 

6.5 Multiprojects 

By using multiprojects, you can structure your STEP 7 projects so that they are 
smaller and thus clearer and easier to use. For instance, with multiprojects you can 
create one project for each of the editors to work on at their own local workstations. 
These projects can be stored on different programming devices/PCs. Using the 
multiproject approach; you can combine all these projects into one overall unit.  

For more information on using multiprojects, refer to the STEP 7 Online Help. 

In a STEP 7 multiproject, an editor working at Computer 1 ("client") can access 
information in a STEP 7 project on Computer 2 ("server"), such as in the case of 
interproject functions. When working in this environment, please observe the 
information in the following notes: 

There are two fundamentally different ways of working with 
multiprojects 
• The projects in a multiproject are centrally stored on one server 



In this case, the projects in a multiproject are all stored on a central server. Editors 
working on the individual projects can access the projects stored on this server 
directly from their workstations. 

If many projects are opened simultaneously on this central server (more than 20 
projects in a multiproject) and if interproject functions are also triggered, you may 
only use "MS Windows Server 2003" as the operating system on the server (no 
other MS operating systems may be used due to operating system limitations, not 
even Win2000 Professional).  

• The projects in a multiproject are distributed over many computers 

Each editor has "his project" on his own programming device/PC and only edits this 
one project. An editor responsible for managing interproject functions has the 
multiproject on his PC. The distributed storage of the project (one project per 
programming device /PC) means that the limitations of MS Windows operation 
systems will not be reached.  

Both methods of managing a multiproject can be used in sequence or in alternation 
during any phase of the project. For example, during its initial stages, a project can 
be distributed over many workstations and worked on locally. During the end stage, 
(such when being placed in service), the project can then be stored on a central 
server and accessed there. 

To avoid problems caused by operating system limitations and access conflicts, 
those editors working on individual projects should open them separately and not 
from within the multiproject.  

 

Caution 
If interproject functions are being used in a multiproject, then it must absolutely be 
ensured through coordination with the project manager that no one is working on 
the projects concerned while these interproject functions are running. 

Examples of such interproject functions are those in the SIMATIC Manager such as 
File > Multiproject > Adjust Projects... or, if the multiproject itself is selected: 
File > Save As, File > Reorganize and File > Archive. 

If you receive a message that a project / a server is not available, exit all projects / 
multiprojects without saving and then restore the connection to the server. 

 

Furthermore, please be sure to observe the requirements and recommendations for 
working with multiprojects as described in the online help. 

Archiving multiprojects on diskettes 
Multiprojects cannot be archived on diskettes. 



6.6 Swapping Different Versions of STEP 7 

Projects in version 2 
• The project data from STEP 7 V2.1 can only continue to be used in STEP 7 V5.4 

including SP3 if these project data have been imported into a project in the 
current version.  

• If a V2.1 project with CP 443-1 and CP 443-5 is changed to a current project 
using the "Save As" command, no system data are created in the CP objects 
that appear in the project path. The "Blocks" folder is empty. System data are 
only created after opening the "Configuring Connections (Configuring Network)" 
application and selecting the "Save and Compile" command.  

Projects from version 3 and higher 
• Projects that were set up and edited with STEP 7 V3.1, V3.2 or higher can 

continue to be used unchanged as (current) projects with STEP 7 V5.4 including 
SP3. 

• For multiple-user operation, existing V3.0 projects must be converted to projects 
for the current version using the menu command "Save as, with reorganization". 

New modules in earlier STEP 7 versions 
• If, in STEP 7 V5.4 including SP3, you assign parameters to modules and these 

parameters were not yet contained in an earlier version of STEP 7, then these 
modules and their subordinate components will not be displayed in STEP 7 
versions earlier than V5.1 SP3. If you have assigned parameters to modules that 
were added on through an optional package, they also will not be displayed if the 
project was created in a STEP 7 version earlier than V5.1 SP3. 

As from STEP 7 V5.1 SP3, a generic object is used to represent these 
"unknown" modules. 

 

Caution 
If objects with messages are edited (e.g. blocks with block-related messages, 
symbol tables with symbol-related messages, blocks with S7 PDIAG monitoring or 
programs with user-defined messages) in a project with a version of STEP 7 <= V5, 
this project may not be opened by another PG/PC with a STEP 7 V5.3 version or 
later. This means the project has to be closed on a computer with an earlier version 
of STEP 7 even for only read access! 

 

Assigning unique message numbers for the CPU (new as from V5.2) or 
for the project 
• Please note that in projects in which messages numbers are assigned for the 

CPU (new procedure), that only those programs, blocks or symbols without 
message configuration (such as user-defined messages, block messages, scan 
messages, S7-PDIAG configurations) can be edited in earlier versions of STEP 
7 (such as V5.1). It is not possible to convert CPU-based message assignment 
to project-based message assignment.  



Please refer to the notes in the "Message Configuration" section. 

Micro Memory Card (MMC) 
• As of STEP 7 V5.1, blocks, system data and STEP 7 standard projects can be 

saved to an MMC. In STEP 7 Lite and STEP 7 as of V5.3, files of any kind can be 
saved to an MMC. 

6.7 Libraries and Sample Projects 

• A number of libraries and sample projects are supplied with STEP 7 V5.4 
including SP3.These sample projects can be deleted in the SIMATIC Manager. 
To reinstall them, you will need to run the STEP 7 V5.4 including SP3 Setup 
program again. Sample projects and libraries are only installed if you run the 
whole STEP 7 Setup again. 

 

Note 
Sample projects and libraries shipped with STEP 7 V5.4 including SP3 are always 
copied when you install STEP 7. If you have edited the standard sample projects, 
they will be overwritten with the original examples if you reinstall STEP 7.  

You should therefore make a copy of the standard examples before you make 
changes to them and then make changes to the copy. 

 

6.8 SIMATIC Manager 

• In certain circumstances, the wait cursor will not appear or will disappear too 
early during long operations. 

Accessible Nodes 
• In contrast to the S7-300 function modules, the S7-400 function modules (such 

as the FM 456) are not listed in the "Accessible Nodes" list. Thus, if you want to 
execute a memory reset on an FM 456, for example, this will have to be done in 
the online view of the project where all the configured function modules (for both 
S7-300 and S7-400) are listed. Alternatively, you can also execute a memory 
reset on the function module using the key switch. 

• The "Accessible Nodes" and "Memory Card" views are not always automatically 
updated. You can update both of these windows by pressing the F5 key. 

• PROFINET IO: The maximum number of nodes in a PROFINET IO network is 
limited to 512. 

Programs for Archiving and Retrieving Files 
The selection of tools for archiving or retrieval has been changed in the SIMATIC 
Manager under Options > Settings > Archive: ARJ32 V3.x, JAR, LHARC and WinZip 
Automatic are no longer offered. ARJ 2.50a provided on the disk has not been 
approved for Vista, but it can be used under MS Windows 2000 and MS Windows 



XP. Therefore, "ARJ via PKZip" is now offered for operating systems because PKZip 
can open most ARJ archives. Please take this into consideration when upgrading 
from STEP 7. The help information on this topic will be updated in the coming service 
pack.  

 

Note 
Multiprojects cannot be archived on diskettes. 

Archiving with PKZIP requires considerably more time on network drives than on 
local drives. 

 

 

Note that archiving projects in STEP 7 V5.4 SP3 with PKZip 8.6 differs from 
archiving projects in older STEP 7 versions. We recommend not to create your own 
subdirectories in directories for STEP 7 projects. The example below shows that 
otherwise additional files from these manually created subdirectories (e. g. backup 
files you created yourself) might be archived as well. 

Example for a project backup: 

S7_Proj 

my_Project_1 

Project1_Files*.* 

my_Subdirectory 

my_Project_1 

any_Files*.* 

The archiving of "my_Project_1" is triggered in the SIMATIC Manager with the menu 
command "File > Archive". 

Up to now, when "my_Project_1" was selected in the "S7Proj" directory, STEP 7 only 
archived this project directory and all its files ("Project1_Files*.*"). 

PKZip 8.6 in STEP 7 V5.4 SP3 also finds under "S7_Proj" the identically named 
"my_Subdirectory\my_Project_1" subdirectory and archives this as well. Due to 
these additional files the archive can therefore no longer be opened by SIMATIC 
Manager. 

Ensure that there is no such structure before performing any archiving. 

If you have created an archive with additional files, the following workaround can be 
used:  

• If the attempt to retrieve the archive fails with the SIMATIC Manager, a message 
appears naming the path in which PKZip has temporarily unzipped the project 
(e. g. "...\S7Proj\S7TEMP001"). You can open the project there and use the 
"Save as" command, for example, to store it in another destination directory. 

• Save the project manually with PKZip in a project directory. Ensure that you do 
not unintentionally overwrite any files that might already exist there. 

 



UNC path 
• As of STEP 7 Version 5.2, projects that are stored on other computers in a 

network are always added to local project management through their UNC path 
(UNC = Universal Naming Convention; that is, \\<Server_Name>\<Share>\...) 
when they are opened. This means although it is still possible to open a project 
through a linked network drive, the storage location will be shown in STEP 7 as 
the UNC path (i.e. in the SIMATIC Manager through File > Open/Manage). In 
particular, this also means that projects can be opened in a network by directly 
using their UNC path, and not, as previously, only through linked network drives. 

In contrast, local projects are always added to local project management through 
their physical path (i.e. <local drive letter>:\...), even if they are on a local share. 

If STEP 7 V5.4 including SP3 is installed over an earlier version, the project 
management is updated during setup. 

Compiling and downloading objects 
• The target CPU has to be in STOP in order to download the hardware 

configuration. This can be set before starting "Compile and Download" via the 
SIMATIC Manager (PLC > Diagnostics > Settings > Operating Mode). The 
SDBs for all CPs have to be on the CPU for the automatic download of the 
hardware configuration to be possible.  

• Startup after a successful download is possible after executing "Compile and 
Download" via the SIMATIC Manager (PLC > Diagnostics > Settings > 
Operating Mode).  

• All SDBs are loaded from the offline container at download just as with the 
SIMATIC Manager. The user is responsible for making sure that the SDBs for 
Netpro, GD or other optional packages are up-to-date. 

• In general, the automatic download of hardware configurations is not possible 
for PC stations.  

Save As with Reorganization 
• If the dialog "Modules which cannot be displayed HW updates" is displayed 

when a station is opened in a project, do not perform "Save As" with 
Reorganization for this project. Otherwise, the modules may not be removed 
completely from the database if "Save As" is performed. 

This may occur if you make configurations in a station module, which is not 
known in the current STEP 7 because, for example, a corresponding HW update 
is not yet installed.  

Change log 
• A change log for a project can only be written if SIMATIC Logon is installed on 

the PC/PG. Please read the information in the section "Note on the use of 
SIMATIC Logon." 

• You should only edit projects with a change log on a PC / PG on which SIMATIC 
Logon is installed. 

• Activities involving the memory card are not contained in the change log. You 
can find additional notes on the change log in the online help. 



6.9 Password Protection 

Access rights:  
Note the following when activating integrated access protection on a CPU from 
STEP 7 V4.02 onwards. If you activate this function and then attempt to process the 
CPU with an earlier version than STEP 7 V4.02, messages will appear telling you 
that this CPU is protected by a password. 

The following messages may be displayed: 

• Protection level not reached 

• Cannot download.... 

• Cannot open.... 

Access rights for M7 modules: 
If you attempt to download a block to an M7 module while the mode selector key is in 
RUN, the message window "Enter Password" appears with the message "The 
module <xxx> is password-protected." This message does not apply to M7 modules 
with M7-SYS RT < V5.0. 

In this case, proceed as follows: 

1. Exit the dialog box with "Cancel." 

2. Switch the mode selector key to STOP or RUN-P. 

3. Call the required function again. 

6.10 Using Symbolic Names (Upper and Lower Case for 
Symbols) 

• If symbols with messages are copied into another symbol table, it could happen 
that the message "Symbol table occupied by another process" appears. In this 
case, save and close the symbol table. After reopening the table you can 
continue to work as usual. 

From STEP 7 V4.02 onwards, you can still use both upper and lower case when 
entering symbolic names. However, when the symbols are processed, this is no 
longer taken into account (in accordance with IEC 1131-3). In other words, it is the 
name itself, and not the way it is written, which is important.  

Example: The symbols "Motor" and "MOTOR" refer to the same variable. 

For more information, refer to the corresponding section in the online help or 
in the manual "Programming with STEP 7."  

In order to be able to use this functionality with older projects created with software 
versions preceding STEP 7 V4.02, you must: 

• Open the symbol table with the Symbol Editor. The names are then adapted 
automatically, or 

• Reorganize the project. 



When doing so, you should make sure that the projects are not write-protected. 
Afterwards, you can then continue using the project in both the current version and 
earlier versions. 

• If two identical symbols have been used in the symbol table, one with upper case 
and one with lower case, the symbols will be marked as non-unique. You can 
display non-unique symbols in the Symbol Editor using a filter. 

6.11 Hardware Configuration (Central) 

CPUs with MPI/DP interface: 
• Make sure that you do not select a transmission rate that is not supported by 

your programming device/PC when configuring these interfaces. If you do 
reconfigure this setting, you will no longer be able to establish an online 
connection to the CPU via this interface.  

Possible remedies: 

1. Use a second interface with the same transmission rate as your programming 
device/PC.  

2. Create a new station in an STEP 7 project. Configure the CPU in your new 
station with your default settings in the "Configuring Hardware" application. After 
saving and compiling, copy the system data in the SIMATIC Manager to an S7 
memory card. Insert the memory card in the CPU and carry out a memory reset. 

• If you have uploaded data from a reset CPU, you must reconfigure the MPI/DP 
interface. 

• If the MPI Address of a module (CPU/CP/FM) in a 300 Station is changed, it is 
recommended to load the complete station. Otherwise, it is possible that the 
module cannot be reconnected.  

S5 adapter modules 
• When you use a number of S5 adapter modules in an S7-400 station, no check 

is made to determine whether the S5 addresses overlap in the P/Q/IM3/IM4 area 
across the modules. You have to ensure that no S5 address that is already 
occupied is used in the input dialog box for the S5 adapter module/IM463-2. 

• No S5-analog input/output modules can be used or addressed in the user 
program in the S5 adapter module. S5-analog input/output modules can only be 
used in SIMATIC-S7 systems in the IM463-2 or via DP interfaces. 

ASCII import: 
If you wish to import a STEP 7 V5.0 SP1 created ASCII file in the format "readable", 
it is necessary to make changes in the file beforehand.  

• When using CPU 318 or CPU 417:  

- Replace "TEST_ON_WARM_RESTART" with 
"TEST_ON_COMPLETE_RESTART" 



- If the value "WARM_RESTART" is entered under the keyword 
"STARTUP_AFTER_POWER_ON", then change the former to 
"COMPLETE_RESTART". 

• If your configuration contains a CPU 313 with MLFB 6ES7 313-1AD02-0AB0: 

- Replace "SYNC_TYPE" with "SYNC_TYPE_SYNC_IN_PLC" 

- Replace "TIME_INTERVAL" with "TIME_INTERVAL_SYNC_IN_PLC" 

• For multicomputing configurations: 

- After the keyword "MULTIPROCESSOR_OPERATION" you have to change 
"SINGLE-SYSTEM" to "MULTICOMPUTING" and "MULTI_SYSTEM" to 
"SEGMENTED_MULTICOMPUTING". 

• If a slave of the type DP/AS-i Link 20 E was exported with STEP 7 V5.0 SP3, 
replace the machine-readable product designation (MLFB) "6GK1 415-2AA10" 
by "6GK1 415-2AA01" when using STEP 7 to import. 

• If a station is imported with a different language setting to that used for exporting, 
PROFIBUS slaves which are installed via language-specific GSD files have to 
be reconfigured.  

• In the file format "Compact"(set in the Dialog box Station > Export) no changes 
are necessary. 

Report system error 
• If you also want to trigger self-defined messages when calling a user block, then 

configure another block that will generate the message. Call this block in the 
user block. 

• The "CPU in Stop“ setting has been simplified for Version 5.4 Service Pack 2. 
The error classes Rack error, PROFIBUS DP master system error, PROFIBUS 
DP slave error, PROFINET IO system error and PROFINET IO device error 
have been merged into a single error class, "Rack error". If different settings 
have been made for the merged error classes in the previous configuration, you 
should check the "CPU in Stop" setting for rack errors. 

Other issues 
• Deleting parameter data (SDB>1000): Some FMs and CPs not only store their 

parameter data in system data blocks (SDB) > 1000 on the CPU but retain this 
data themselves. If the SDBs are then deleted from the CPU, the FMs or CP will 
continue to have parameters consisting of the previously valid data. For more 
information, refer to the description of your FM or CP. 

• For reasons having to do with ensuring data consistency, in multi-user operation 
(several users working on a project at the same time) only one other station can 
be used at the same time. 

• If, when configuring an M7 mass storage module, you get the error message that 
there are not enough AT addresses available, you can insert the mass storage 
module after you have deleted an IF module. After this you can re-insert the IF 
module. 

• If your configuration contains module from earlier optional packages, it may 
happen that not all data in this modules is acquired ("captured") when using the 



"Export station" function. In this case, check whether the module data are 
complete after the import process is complete. 

• If you use the CPU function "Hot Restart", make sure that the module address 
area does not exceed the process I/O image range. 

• PLC > PROFIBUS > Diagnose, Monitor/Modify Node: 

For slaves with bit-granular I/O devices (such as ET 200S or ET 200L-SC, 
DP/AS-i Link), the bit-granular configuration of the I/O devices may not be 
interpreted as being bit-granular when the configuration data are read back in 
from the slave. For this reason, these slaves are only displayed with byte-related 
I/O and cannot be configured again as bit-granular by using the menu command 
Options > Specify Module. They cannot be controlled on a bit-granular basis 
but only on a byte basis. 

• When a slave is monitored/modified, all rows are modified, even if all the rows in 
the list cannot be viewed at the same time. This behavior is different from the 
case when modules are monitored/modified in HW Config. 

• As of STEP 7 V5.3, the program verifies whether the area of a set I/O address is 
fully within or outside the process image (PI). If this is not specified in already 
existing stations, during the consistency check, you are referred to the program 
and given the possibility to adjust the address to suit your needs. 

6.12 Hardware Configuration (PROFIBUS DP) 

Cross-reference 
• Note when configuring direct data exchange (DP cross reference) that both the 

station at which the slave is configured as sender and the receiver must be 
downloaded. 

• Copying from stations, among which there are communication relationships (for 
example, data cross-reference), in other projects must be carried out jointly. 
Otherwise these communication relationships will be lost during copying. 
Therefore, select the other stations and then begin copying.  

• On downloading a configuration, the program does not check whether the 
product revision of the DP slave supports the function "sender in direct 
communication link." You should therefore observe the scope of performance of 
the DP slave (compare versions, if this is available in the configuration).  

Constant scan time 
• When you configure both "constant scan time" and sync/freeze groups for 

PROFIBUS DP, note the following: 

• Group 8 cannot be used (reserved for constant scan time clock). If you have 
already configured the group assignment as group 8, you cannot set constant 
scan time.  

• The function for setting constant scan time cannot be used for the DP slave 
DP/AS-i_Link ET 200B analog, ET 200-SC up to product version 5, ET 200X, IM 
153-1 up to version 3 and IMSC up to version 5. 



• When the constant scan operating mode is selected, a programming device on 
the PROFIBUS may not be able to enter the ring. If this occurs decrease the 
HSA as much as possible or select an interface without automatic bus parameter 
recognition and try it again. 

• PROFIBUS Slaves, which do not support SYNC- or FREEZE-commands, 
cannot be used for the function "Constant scan time". 

• In the case of ET 200M 6ES7 153-2BA00-0XB0 and 6ES7 153-2BB00-0XB0, 
there is no provision for using active backplane bus modules for operations 
using constant scan time. The configurable minimum times only apply to 
operation without active backplane bus modules.  

Note: Should active backplane bus modules nevertheless be used, a time period 
of 1 ms should be added to the Tdp by the user. 

Sync/Freeze: 
• M7-CPUs and M7-FMs with M7-SYS RT V5.0 support the SYNC/FREEZE 

functionality with the DP-Interface 6ES7 964-2AA02-0AB0 only when the 
corresponding Profibus is set to "Constant scan time" and the corresponding 
group 7 slaves are assigned.  

• There should be no FMs or CPs inserted in the ET 200M peripheral I/Os 
assigned by STEP 7 Sync/Freeze-Groups. 

Switching languages 
• After you have changed the language, you must restart HW-Config once more 

before copying from stations with DP configurations. 

• If the set language differs from the one used during configuration, it may happen 
that not all DP slaves modules are imported with the menu command Station > 
Import. Solution: Import the configuration in the original language and reset it 
afterwards. 

I-slave: BM147 and IM151/CPU: 
• When configuring the BM147/CPU (ET 200X) and IM151/CPU (ET 200S9 with 

intelligent preprocessing, use a SIMATIC 300 station.  

• The module BM147/CPU must also be networked in the configuration with a new 
PROFIBUS network if it is being used as a stand-alone (separate operation) 
device. 

• Downloading or uploading the IM151/CPU is only possible if the access point 
S7-Online in the PG/PC corresponds with the interface that is supported or 
configured by the module. If you use the IM 151/CPU without switchable MPI/DP 
interface you must set the PROFIBUS interface (see SIMATIC Manager: Setting 
the Programming Device/Personal Computer Interface ...).A download or upload 
of the IM 151/CPU is only possible if the access point "S7 online" in the PG/PC 
matches the one supported by the module or configured interface. For the IM 
152/CPU without a switchable MPI/DP interface, the setting should be 
PROFIBUS interface (see SIMATIC Manager, Set PG/CP interface...)  



DP slaves 
• The SFCs 5 and 49 which are used for converting geographic to logical 

addresses and vice versa for slaves which are interconnected via the GSD file 
supply correct values only in the following configurations: 

The DP slave is connected to a 300 CPU with firmware V2.0 or higher or a 
master in the operation mode DPV1. In case of fault the SSL 0x91 supplies an 
incorrect parameter "adr 2" (Slot, Interface No.) in a record for these slaves. 

Diagnostic repeater 
• In DPV0 operating mode (DP alarm mode), diagnostic events will cause OB 82 

to be called. In DPV1 operating mode, OB 82 is only triggered by a diagnostic 
interrupt. If the diagnostic interrupt is not offered as a DPV1 interrupt in the slave 
parameters, then this is not supported by the given slave. 

• For this reason, the diagnostic repeater should be used in DPV0 operating 
mode. 

• Topology display (PLC > PROFIBUS > Show Network Topology): 

Under certain conditions (number of nodes connected to the network, baud rate, 
etc.), a "time out" may occur for an online connection and not all the data may be 
read from the diagnostic repeater and displayed. In this case, we recommend 
that the interface settings for CPxxxx (PROFIBUS) be reset to 10s in the 
properties dialog. 

Preparing for line diagnostics 
• With interface "CPxxxx(Auto)" it not possible to measure the nodes at the 

PROFIBUS DP. The interface must be set to "CPxxxx(PROFIBUS)". 

• The onboard MPI interfaces for PG740 and PC-Adapter (PC/MPI cable 
6ES7901-2BF00-0AA0) does not support the function "Prepare Line 
Diagnostics". If the function is started in STEP 7 anyway, the measurement will 
be stopped at end of a monitoring time. In this case, the reporting status" 
Determination stopped" will be displayed in STEP 7 with the additional text " 
Time monitoring addressed". 

• The following interface cards support the function for measuring the nodes on 
PROFIBUS-DP: CP 5511, CP 5512, CP 5611.  

• When the dialog "Prepare Line Diagnostics" is active, online connections cannot 
be established to the network transitions. During a network transition to the CPU 
of a module, the module status cannot be called in the "Prepare Line 
Diagnostics" dialog.  

 

Note 
If there is a PROFIBUS line behind an IE/PB link 6GK1 411-5AB00 (as a PN IO 
device), such a network transition is given, however this is not the case behind a 
network transition 6GK1- 411-5AA.. or 6GK1-411-5AB00 (as pure network 
transition) or for a PROFIBUS line without a link transition. 

 



IM-157 
Note that the assignment of parameters on the CPU may be aborted when using the 
IM 157 as an interface module for PA slaves if the set transmission rate on the 
PROFIBUS is too low or if you have configured IM 157 modules that do not exist on 
the PROFIBUS. In this case, increase the set monitoring time in the "Startup" tab for 
the CPU by changing the parameter "Transfer of parameters to modules." You must 
also delete the system data in the CPU and then download the new parameter 
assignment to the CPU. 

Updating the firmware when redundant interface modules (IM 157 and 
IM 153) are used  
If you want to perform a firmware update for the IMs in a case where  
IM 157-0AA82-0XA0 or IM 153-2BA00-0XB0 is redundant proceed as follows:  

1. Connect the PG to the PROFIBUS subnet, to which one of the two IMs is 
connected.  

2. Update the firmware as described in the Online Help (Menu command PLC > 
Update Firmware in HW Config). 
If you select the 'Activate Firmware after download' option and the IM is active, a 
switchover will occur on the active channel.  

3. Connect the PG to the PROFIBUS subnet, to which the other IM is connected. 

4. Repeat step 2 for the second IM.  

 

Caution 
If the PG is not directly connected to the PROFIBUS, you will not be able to 
determine whether both modules can be addressed via the STEP 7 Routing 
mechanisms. 

 

System changes in runtime using CiR 
 

Caution 
Loading the current configuration form the automation system to the PG (Menu 
command PLC > Download to PG) will cause your station to lose the CiR 
capability.  

It is therefore strongly recommended not to perform this download procedure. 

 

Loading stations with CiR objects in RUN mode 
• "Loading in RUN mode" may possibly be rejected if there are further Multi 

systems located next to the Master system in the CiR objects in the station or the 
station was last loaded with STEP 7 V5.3 or older in "STOP" mode. To remedy 
this, the configuration has to be loaded once in STOP mode onto the CPU. 

• If your station contains a CP 443-5 or 443-1 and was downloaded with STEP 7 
V5.3 SP1, V5.3 SP2 or V5.3 SP3, it may be necessary to download the 



configuration once in STOP mode to the CPU, to enable a correct CiR behavior 
for the future. 

• If CiR modifications are made to a DP-Slave ET 200iSP with inserted 8 DI 
NAMUR modules, it is necessary to save and compile the modified configuration 
before a download in RUN. 

Revision 3, GSD files 
New functions in GSD Revision 3 are supported with STEP 7 V 5.1. Backwards 
compatibility with STEP 7 versions < V 5.1 is not ensured for DP slaves with these 
functions. If such DP slaves were configured with STEP 7 V 5.1, the project can only 
be processed in STEP 7 versions < V 5.1 if the following conditions are observed: 

• The slave can be used only in the operation mode DPV0. 

• In the case of function-modular devices only modules may be placed which are 
allowed at the corresponding slots. This limitation is not monitored for STEP 7 
versions < V 5.1. 

• Modules which occupy more than one slot in the DP slave are split into individual 
modules. The module whose name begins with "????" and the following module 
called "-->........" form a unit and may not be changed.  

Symbols 
• Modules whose input or output data consist of different data types are currently 

offered with a byte-oriented symbols. If the number of data amounts to 3 or more 
bytes, these data can only be accessed as a whole (by using the SFC 14 and 
SFC 15) although a symbol is specified for every byte. 

Reporting system errors 
• Distributed I/O components which are connected via CP 342-5 are not 

supported by "Report system error". Distributed I/O components which do not 
fulfill the standards completely are also not supported completely by the "Report 
system error" function. 

• The ET 200X 6ES7 147-1AA01-0XB0 (< firmware version 2.1) is not supported 
by "Report System Errors". This is indicated by the fact that you receive an error 
message when you try to download the generated blocks to the CPU. In this 
case, delete the generated SFM block and the created SFCs from the project. 

Inserting redundant slaves 
• It is not yet possible to insert redundant DP slaves in DP V1 mode using the 

ET200S (6ES7 151-1BA01-0AB0) in combination with the power module (6ES7 
138-4CA50-0AB0. 

Miscellaneous 
• PA slaves cannot be operated with the CP 342-5 MLFB 

6GK7342-5DA00-XXXX, 6GK7342-5DA01-XXXX, 6GK7342-5DA02-XXXX and 
CP 342-5 FO MLFB 6GK7342-5DF00-0XE0 

• For the correct operation of an ET 200U (MLFB:6ES5318-8MB1 or 
6ES5318-8MC1) on the DP/PA link (MLFB: 6ES7 157-0AA81-0XA0) an even 



number of slots has to be configured. The last module in the ET 200U has to be 
configured as a dummy module. 

• If configuration modifications are made to a DP slave ET200iSP with inserted 8 
DI NAMUR modules, you have to check the configuration of the 8 DI NAMUR 
modules following the modification, because their configuration may have also 
changed. 

6.13 Hardware Configuration (PROFINET IO) 

IM466 and CP 443-1  
If IM466s and CP 443-1 Advanced are configured in a rack, all the IM466s have to be 
inserted between the CPU and the CP 443-1 Advanced. 

Reporting system errors 
"Report System Error" supports PROFINET IO in the following configurations: 

PROFINET IO Controller: 

• CPU317-2 PN/DP / V2.3, V2.5, V2.6 

• CPU315-2 PN/DP / V2.3, V2.5, V2.6 

• CPU319-3 PN/DP / V2.4, V2.5, V2.6 

• IM 154-8 CPU / V2.5 

• CPU41x / V4.0 with CP 443-1 Advanced (6GK7 443-1EX40-0XE0) / V2.1 (or 
higher)  

• CPU41x PN/DP / V5.0 with CP 443-1 Advanced (6GK7 443-1EX41-0XE0) / V1.0 
(or higher) 

• CPU41x PN/DP / V5.1 with CP443-1 Advanced (6GK7 443-1EX41-0XE0) / V1.0 
(or higher) 

Notes: 

• For S7-400 (with CPU 41x / V4.x and CP 443-1 Adv.), "Report System Error" 
only supports the runtime behavior. No message is output at hot or warm restart.  

• The use of "Report System Error" is not supported by CP 343-1 Adv. 

• SFM supports diagnostic pictures via the generated DB126 for the PROFINET 
IO controller CPU317-2 PN/DP / V2.3, CPU315-2 PN/DP / V2.3, V2.5, V2.6, 
CPU319-3 PN/DP / V2.4, V2.5, V2.6, IM 154-8 CPU / V2.5 and CPU41x PN/DP 
/ V5.0, V5.1 with CP443-1 Advanced (6GK7 443-1EX41-0XE0) / V1.0 (or 
higher). 

Updating the GSD file of a PROFINET IO device 
If the function Change Release Number function is aborted during the update of 
GSD files, there will be an inconsistency between the current and desired release 
number. This inconsistency occurs, for example if you have used an old GSD file to 
configure a module which is not contained in the new GSD file. In this case you 
should delete the device and then reconfigure it. 



PN/PN coupler 
The device names of the PN/PN coupler can only be saved to the MMC if both 
interfaces of the coupler are configured in the same project. The transmission of both 
device names to the MMC is not supported if the coupler is configured using GSD. 

Configurations with CPU4xx V5.0 and more than 16 devices 
For certain configuration with the CPU4xx V5.0 as PN-IO controller, individual 
devices may not operate. These configurations are identified as follows:  

• When the send clock of the controller is set to a value less than 1ms. 

• When devices not configured using GSDML are used:  

ET200S 

- IM 151-3 PN with MLFB "6ES7 151-3AA10-0AB0" (from HSP0089)  

- IM 151-3 PN with MLFB "6ES7 151-3AA20-0AB0" (from HSP0098)  

- IM 151-3 PN HF with MLFB "6ES7 151-3BA20-0AB0" (from HSP0099) 

ET200pro 

- IM 154-4 PN HF with MLFB "6ES7 154-4AB00-0AB0" (from HSP0092)  

• More than 16 devices are configured. 

Remedy:  

• Set the send clock on the controller to at lease 1ms or, 

• configure one or more of the devices described above using GSDML, or  

• increase the update time for at least one of the devices used. 

6.14 Redundant I/O: Channel-granular Redundancy 

For channel-granular redundancy, the signal modules listed below are currently 
approved: 

 
Module Order number 

DI16xDC 24 V 6ES7 321-7BH01-0AB0 
As of product revision 2, this module can also be deactivated on a granular channel group 
basis. In the event of an error on one channel, the entire group (2 channels) is deactivated. 
DO 16xDC 24 V/0.5 A 6ES7322-8BH01-0AB0 
This module can also be operated in channel-granular redundancy. 
DO 10xDC 24 V/2 A 6ES7326-2BF01-0AB0 
As of product revision 3, this module can also be operated in channel-granular redundancy.
AI 8x16 Bit 6ES7 331-7NF00-0AB0 
As of product revision 10, this module can also be operated in channel-granular redundancy.
AO8x12 Bit 6ES7332-5HF00-0AB0 
As of product revision 5, this module can also be operated in channel-granular redundancy.

 



Changed characteristics for the parameters CH_INF_H and CH_INF_L 
des FB 453 "RED_STATUS" 
When all of the channels of a module show errors, as of v4.0 of the 
"Channel-granular redundancy" library the bits assigned to the channel are set to 0 
in the CH_INF_H and CH_INF_L output parameters. 

All parameters were set to 0 in the previous version. 

You can find information about redundant I/O in the manual "Automation System 
S7-400H; Fault-tolerant Systems". Read the description for the procedure involved 
in case of failure and for exchanging the I/O or function module. 

Depassivation after a plant change in runtime 
Perform a complete passivation after changing the plant in runtime (CiR). 

Channel information bit of the FB 450 "RED_IN" 
The "Channel information available" bit in the status/force word 
"FB_RED_IN.STATUS_CONTROL_W" of the instance-DB of FB 450 "RED_IN" is 
only relevant for fail-safe modules. 

FC 450 "RED_INIT" 
FC 450 "RED_INIT" deletes all blocks configured in HW Config for the number range 
in the work DBs. 

Wire break detection with a HART AI module 
If the wire break detection is deactivated for a HART AI module in HW Config and a 
wire break is caused in a single channel, FB 453 "RED_STATUS" reports an 
underflow in the MODUL_STATUS_WORD. 

Reaction of FB 450 "RED_IN" 
If FB 450 "RED_IN" detects an error in a module, the affected channel is passivated. 
If another error occurs in the corresponding channel of the second (redundant) 
module before the first error is remedied, it is not shown at the CH_INF_L or 
CH_INF_H output parameter. The CH_L or CH_H parameter correctly shows that an 
error has occurred. 

6.15 Hardware Diagnostics 

• The hardware can only be completely diagnosed if the CPU supports special 
diagnostic functions. If a CPU does not have all necessary diagnostic functions, 
some of the diagnostics symbols are displayed with reduced contrast. If you 
require a complete diagnostic display, check, in this case, the version of the 
module using the menu command "Module Information" and ask the SIMATIC 
Customer Support if a firmware update for your CPU is advisable or is at all 
possible. 

• If a station with a CR2 rack (operation in a segmented rack) is to be diagnosed, 
always select the CPU you want to display in the online project in the SIMATIC 
Manager. Depending on the CPU capabilities, the other CPU may also be 
displayed. If the diagnostics symbols for all modules in the station are shown 



grayed out, you should connect the programming device directly to the interface 
of the CPU you want to diagnose. 

• If the error message "Download of the configuration to the programming device 
has been aborted" is generated, the temporary directory for system diagnosis 
may not be created. Solution: take care that the standard STEP 7 project 
directory (Siemens\Step7\S7proj) is not write protected and that enough 
memory is available.  

• If the error message "The directory... could not be deleted." is generated, 
another application is blocking the deletion of the temporary project from a 
previous session. The hardware diagnosis will be blocked. Solution: Close the 
application which is blocking the deletion of the temporary directory, and restart 
the hardware diagnosis. 

• An H Station can only be fully diagnosed if there is an online connection to the 
both CPUs.  

6.16 Configuring Connections 

• If connections were configured in a project with earlier version of STEP 7 (V2.1, 
V3.x), they may be lost when you exchange a CPU. The solution here is to 
delete the connection as of STEP 7 V5.2 and to reconfigure it. Then you can 
exchange CPUs (as from V5.2) without encountering problems. 

• S7 connections created with STEP 7 V4.x/V5.x can only be edited to a limited 
extent with STEP 7 V3.1. Deleting S7 connections and changing the connection 
partner are not then possible. 

6.17 MPI / PROFIBUS Network Settings 

Network settings 
• For MPI and PROFIBUS networks, a "highest MPI address" or "highest 

PROFIBUS address" (HSA) must be configured. We recommend that you use 
the default values proposed by STEP 7 for new projects.  

- If you want to connect to a network using a programming device/PC, you 
should ensure that the address of the programming device/PC does not lie 
above the HSA. The default value for the highest MPI address was 15 for 
STEP 7 V2.1 projects. 

- The other network settings must also be the same on all stations in a subnet. 

- After making changes to network settings, the configuration should be 
downloaded to all SIMATIC stations in this network so that the settings are 
the same for all stations. 

• At 19.2 Kbps, no more than 8 nodes should be operated at the MPI interface of a 
CPU. 

• If the MPI/DP interface for a CPU318 is operated as a MPI interface at 19.2 
Kbps, the HSA may not be set to 126. 



• To assign a PROFIBUS address to an ET 200C station, only the programming 
device/PC should be the master on the PROFIBUS DP. The address 
assignment is only possible with the CP 5511, CP 5512, CP 5611 and CP 5611 
on-board, not with PC or TS adapters. 

 

Caution 
If you make a setting using the wrong bus parameters when you connect the 
programming device/PC to the bus, the bus may be subject to major disturbances 
to the point where other bus nodes (such as DP slaves) may fail. You must also 
observe the notes on PROFIBUS-DP address assignment in the section "Hardware 
Configuration (PROFIBUS DP)". 

 

• Older PC and TS adapters (PC/MPI cable for MPI connection via the COM port 
of the PC/PG) can only be used for MPI and not for PROFIBUS (DP, universal). 
PC and TS adapters from V5.0 can be used with MPI and PROFIBUS up to 1.5 
Mbps. The TS Adapter II can be used with MPI and PROFIBUS up to 12 Mbps. 

• If your programming device /PC can only reach a module through a gateway, 
STEP 7 will always select the shortest path to the module. However, if 
communication is not possible through this gateway (line interrupted, etc.), the 
connection will not be established. If there is an alternative way of reaching the 
module through other gateways, STEP 7 will automatically attempt to establish 
the connection through these other gateways. The sequence in which these 
attempts are made can be set in the properties dialog for the STEP 7 program. 

To do this, proceed as follows: 

1. Open the online view of the project. 

2. Navigate to the STEP 7 program associated with the CPU. 

3. In the properties dialog for the STEP 7 program, open the "Addresses: Module" 
tab (menu command "Object Properties"). 
Here you can set an alternative gateway if one is available. 

Address Assignment 
• The addresses of active PROFIBUS nodes must have a gap of at least one 

address with certain modules. In this case, STEP 7 V5.4 including SP3 
automatically assigns addresses which take this rule into account. For example, 
you have configured two CPU 315-2 DP devices without DP Master systems. 
These CPUs will automatically receive the PROFIBUS addresses 2 and 4. You 
can change these addresses, but you must then ensure you allow for the 
PROFIBUS address gap. This also applies to projects which you have already 
created with STEP 7 V2.0/2.1.  

- You must also take the address gap into account when assigning addresses 
to other active bus nodes (for example, a programming device/PC to which 
you assign an address using the "Setting the PG/PC Interface" application). 

 



Caution 
If you do not take into account the address gap between active bus nodes, this may 
cause bus nodes to malfunction or to fail completely (for example, DP slave 
stations). 

 

You should note that if the address is equal to the "Maximum no. of nodes," the 
address 0 should not be used. 

• The station address for a programming device/PC must not be set to the station 
address for a station on the PROFIBUS bus, such as for a DP slave 

6.18 SIMATIC M7 

The following points apply to the operating system used to date, under MS Windows 
Vista M7 components no longer have to be configured. Any existing station with M7 
components can continued to be used, however. 

• With STEP 7 V5.4 including SP3, you can program and configure M7 systems as 
well as SIMATIC S7 and C7 systems. The MPI address can be set during 
configuration. This MPI address is activated in the M7 system after downloading 
with the menu command "Manage M7 System" and switching off the entire 
station with all M7 components and back on again. 

• M7 user programs are programmed with ProC/C++ or CFC (optional packages). 
You create data blocks that you want to use in these programs with your STEP 7 
Standard package. You can also use data blocks from S7 programs in your M7 
program by copying them to an M7 CPU. When copying from S7 programs to an 
M7 CPU, the only block types displayed are those which run on M7 devices. 
When copying the S7 program back to an S7 CPU, the other block types can be 
seen again. 

• When using an external prommer, the use of virus scanner may cause problems 
if the Flash file driver for M7 is activated (Control Panel > Memory Card 
Parameter Assignment). For this reason do not use a virus scanner in running 
operation (see the section "Virus Scanners" in chapter "General Notes"). 

• Formatting memory cards for M7-300/400 

You can format memory cards for M7-300 and M7-400 on a programming device 
or PC with the following commands: 

- \ windows\system32\s7oformx in MS Windows 2000/XP 
(for the syntax of the s7oformx-command see Chapter 5, User Manual 
"System Software for M7-300 and M7-400"). 

- Installing the Optional Package M7 SYS in MS Windows 2000/XP 

The optional packages M7 SYS V4.0 and V5.0 can be installed in MS 
Windows 2000/XP with the setup option -ntall.  

• The buttons "Download" and "Upload" in the dialog box "Manage M7 PLC 
System," "Install Op. System" tab can only be used if you have an M7 operating 
system, version 4.00 or higher installed on the selected target medium and if the 



configuration installed on this medium matches the selection in the 
"Configuration" field of the dialog box. 

• PG/PC functions for M7-300/400 beyond subnet limits 

You can only carry out the following PG/PC functions for M7 CPUs and function 
modules that are nodes in an MPI/communication bus subnet:  

• All functions of the menu command PLC > Manage M7 System, such as 
installing an operating system or downloading a user program to M7-300/400 
devices 

• Remote terminal interface for operating the M7-300/400 device 

• Debugging C programs for M7 with Organon XDB 

These functions cannot be executed beyond the limits of the subnet. 

Note: M7 is not enabled for use under MS Windows Server 2003 as well as 
MS Windows Vista. 

6.19 Ladder Logic, Function Block Diagram, and Statement 
List, Reference Data 

Blocks and sources 
• As of STEP 7 V5.1 SP3, the STL/LAD/FBD function "Generate source files 

automatically" address settings "absolute/symbolic" (Options> Customize > 
Sources > Addresses) is only effective if the properties of the corresponding 
block folder are set to address priority "absolute" for the block. If it is set at 
"symbolic", symbolic addresses will always be created for the address priority. 

• As from STEP 7 V5.1 you can use the Edit > Check Block Consistency...function 
in the SIMATIC Manager in case of interface problems. 

• With offline blocks that were edited with Version 5, interface changes can now 
also be made in the incremental editor. To do this, proceed as follows: 

Make sure that all blocks have been compiled with version 5, generate a source file 
containing all the blocks, and compile this file. 

1. Change the interface of the block concerned. 

2. Now open all the calling blocks one after another (the corresponding calls are 
displayed in red). 

3. Select the menu command Edit > Update Block Call. 

4. Generate the relevant instance data blocks again. 

• In the ASCII Editor the parameters have to be transferred in a defined order 
when a block is called. Changes to a block interface open online may lead to a 
CPU STOP. 

• Function blocks generated with STEP 7 version older than V5.1 and having an 
OUT parameter with assembled data types, cannot be monitored as from STEP 
7 V5.0 SP3 with the block status. An error is reported when you attempt to open 
the block.  



Remedy: Save the block with STEP 7 V5.4 including SP3 and download it to the 
PLC. 

Function blocks generated with STEP 7 version as from V5.0 SP3 and having an 
OUT parameter with assembled data types, cannot be edited by versions older 
than STEP 7 V5.0 through "Accessible Nodes."  

Remedy: Open the block in the offline project, save it and load it again. 

If the changes described above are not made the block will continue to perform 
as before but cannot be edited.  

When the changes have been made the ENO output of the block is correctly set. 

Language elements 
 

Note 
• The use of high-level language constructions in Statement List, such as the 

following, can lead to the contents of the DB register and the address register 
AR1 being changed: 

- Fully-qualified data block access (for example, DB20.DBW10) as an actual 
parameter for a function (FC), FB and multiple instance CALL 

- Structure components of a formal parameter as an address within a 
function or a function block 

- Structure components of a formal parameter as an actual parameter for a 
function or a function block 

• In a function block, function, or multiple-instance CALL, RLO or accumulators 1 
and 2 may not be used as additional (implicit) parameters. 

• The DI register and the address register AR2 are used by the system for the 
function block and multiple-instance CALL and must not therefore be changed 
within function blocks. 

• Some of the loadable standard blocks use the address register AR1.  

• Within a function block, the command "L P#parameter_name" loads the 
address offset of the specified parameter, relative to the address register AR2. 
To determine the absolute offset in the instance data block of multiple-instance 
function blocks, you must add the area-internal pointer (address only) of the 
AR2 register to this value.  

If you use the above programming methods and the above-mentioned registers and 
accumulators at the same time, you must ensure that the contents of the specified 
registers and accumulators is restored, otherwise this may lead to errors.  

Refer to the topic "Avoiding Errors when Calling Blocks" in the Help on STEP 7 for 
details. 

 

• In the instructions AW, OW, XOW, AD, OD, XOD, binary constants (such as OW 
2#101010101010101) are not supported. Hexadecimal constants (such as OW 
W#16#AAAA) are possible. 



Block parameters 
• Blocks with Boolean input and in_out parameters should only be called by blocks 

with the property "Block Version 2." Otherwise the first Boolean input or in_out 
parameter may, in some cases, not be passed correctly. 

• If you use Boolean output parameters of a call box as the input parameters of a 
second call box, the call boxes must be located in different networks or the 
output parameters of the first call box may have no effect as the input 
parameters of the other call box. 

• If a parameter of the type UDTx is supplied with a data block which also has the 
type UDTx (entry in the symbol table: DBx UDTx), your parameter entry is 
rejected as a type conflict. You can still, however, transfer a DB component with 
the type of this UDTx. 

• In the temporary variable range, only the temporary local data declared by the 
user can be used for programming. This should also be noted when using blocks 
from optional software packages in Statement List, Function Block Diagram, and 
Ladder Logic programs. 

Reference data 
• The time required to display the view selected for reference data depends 

greatly on the number of entries to be displayed. For very long programs you can 
restrict the number of reference data using the menu command Options > 
Reference Data > Filter in the SIMATIC Manager. In the filter for the cross 
references you should only select the address and value ranges relevant for 
your requirements 

When the reference data are generated, the following addresses are not included: 

1. Address in the form of a formal parameter, for example: SP / CU <parameter 
name>. 

2. Addresses from register-indirect statements. 

3. Addresses from memory-indirect statements. 

4. Local data. 

5. Data blocks opened with OPN DIx are displayed in the program structure as 
OPN DBx. 

• After rewiring block calls the reference data may no longer be valid. Therefore, 
you must always generate the reference data after rewiring. 

• In the program editor, (LAD, FBD, STL), a window displays the use locations for 
the addresses in the current network in the entire program (menu command 
View > Details; "Cross-reference" tab). This section of the cross-reference list 
(reference data) contains no cross-references for partially and fully qualified 
accesses to data blocks nor any pointer accesses. 

• The "Unused symbols" view for the reference data lists the symbols that are not 
used in the S7 program. If you have assigned attributes, such as messages for 
display devices, to symbols, be sure to look in the symbol table before deleting 
unused symbols (column "M" for "message properties") to verify that these 
symbols are, in fact, not needed for a display device. This also applies to the "O" 
attributes (Operator Control and Monitoring with WinCC) and "C" attributes 
(Communication Properties). 



 

Note 
The scope of the reference data you want to display has been extended to include 
far more information for STEP 7 V5. If you have programs whose reference data 
were generated in an older STEP 7 version, generate the reference data again in 
the SIMATIC Manager using the menu command Options > Reference Data > 
Generate.  

This enables you to make use of the extended function. 

A filter determines which data are selected and how they are represented for the 
various views of the reference data. If you want to check the default filter settings 
and make any changes you require before the reference data are displayed, select 
the menu command Options > Reference Data > Filter in the SIMATIC Manager.

 

6.20 Message Configuration 

Assigning unique message numbers for the CPU or for the project 
• Starting with V5.3 you can choose between assigning message numbers for the 

project (previous method) or for the CPU (new method). The advantage in 
assigning numbers for the CPU is that programs can then also be duplicated 
within a project without any need to re-assign message numbers. 

• When you first create messages and display texts in a project, you will be asked 
if you want to assign the message numbers uniquely for the project or for the 
CPU. In the SIMATIC Manager, you can set a default (menu command Options 
> Customize > Message Numbers) so that you are not asked this question 
each time you start creating messages.  

This default setting also applies for the menu command File > Save as with 
reorganization, unless the default setting for new projects applies for the for the 
project and your current project applies for the for the CPU (it is not possible to 
change a project so that messages assigned for the CPU are now assigned for 
the project.). 

• If you have selected numbers assigned for the CPU and want to display them on 
an HMI device, this is only possible with the applications "WinCC as of V6.0" 
and/or "ProTool as of V6.0". If you are working with versions of these 
applications lower than V6.0, then you have to select message number 
assignment for the project. 

Existing projects (message numbers assigned for the project) 
• By selecting the menu command File > Save as with reorganization, you can 

convert projects with unique message number assignment for the project (such 
as a project in V5.1 or earlier) over to unique message number assignment for 
the CPU. Please note that in this case new message numbers will be assigned 
and the blocks will have to be recompiled as described below. The changed 
message numbers will only take effect after the PLC has been completely shut 
down and restarted. 



• If blocks which already contain messages are copied from a project in which the 
messages are assigned for the project (previous method), new message 
numbers (EV_ID) are assigned to the messages in the instance DBs. This 
results in incorrect variables being supplied for the message number when this 
copied and inserted block is called. In this case, create a source file from the 
calling block. Delete the variables at the block call in the source file. For 
example, from the call of a block with two messages 

CALL FB 1 , DB 1 ( 
  msg   := DW#16#1, 
  msg2   := DW#16#5); 
the following call results: 
CALL FB 1 , DB 1; 

Recompile the source file of the block containing this call. The new message 
numbers will then be automatically entered for this instance. You can check the 
new numbers supplied by opening the block after compilation. 

Symbols and message configuration 
• If you copy symbols between symbol tables and also want to create 

symbol-related messages during the same procedure, you must first close one 
of the symbol tables. Otherwise, your configurations for these messages cannot 
be saved. Under some conditions, the last entries made in the configuration 
dialog for these messages may be lost. 

Blocks and message configuration 
• Interconnecting the message input may not be carried out with modifiable 

variables. If an instance of a message block is processed, the EV_ID supplied is 
accepted in the PLC during the first run and will not be updated again as long as 
the instance exists. Replacing these parameters with a different value than in the 
first run has no effect. 

• If a message-type block is opened in the LAD/FBD/STL Editor and the menu 
command File > Save As is selected, the corresponding messages will not also 
be copied!. If, during this process, an already existing block is overwritten, its 
message configurations will be lost! In this case, a warning is displayed. When 
copying a block with its configured messages, please use the menu commands 
Edit > Copy or Edit > Insert in the SIMATIC Manager.  

6.21 Translating Texts 

Copying objects:  
If objects are copied from project to project with configured display texts (for 
example, message blocks, symbol tables with assigned messages), you should 
make sure that the required display languages are available in the target project 
(check using the menu command Options > Language for Display Devices). Not 
all the display languages which exist in the source project will be created 
automatically in the target; instead, only the texts whose languages have been 
created in the target object are copied. 



6.22 Managing Multilingual Texts 

Importing display texts (menu command Options > Manage texts in 
several languages > Import):  
When importing display texts (S7UserTexts, S7SystemTextLibrary and 
S7UserTextLibrary) it is possible that an access error is reported in the log file 
<import.txt>, because the operating system may still be causing internal process to 
access this object. In this case repeat the importing process under observation of the 
specifications below. The access error should then no longer occur.  

Ensure that no editors or applications are opened with the above-mentioned objects 
(editors from the main menu Options > Text Libraries > User Library or System 
Library for user texts or system text libraries). 

Before importing always close the log file <export.txt>. If <export.txt> is opened, an 
access error can occur while display texts are being imported. 

For the function "Managing multilingual texts" you can use a Microsoft Office Excel 
version as of EXCEL 97 SR2 up to and including version 2007. 

6.23 S7-PDIAG 

S7-PDIAG and address priority 
• If changes in symbols result in changes to process diagnosis data for which the 

set address priority is to be followed, then these changes will be made when a 
project is opened with the application S7-PDIAG or when a block with diagnostic 
capability is opened in the LAD/FBD/STL editor. These changes are not made in 
the symbol editor. 

New file type in the "Export" dialog box  
• In the "Export" dialog box (using the menu command Process Diagnostics > 

Export), the file type data has been extended by the "*.xml(ISO88)" entry. If you 
select this file type the XML format will be generated with the encoding 
"ISO-8859-1". If you select the ".xml" file type the encoding will be "UTF-8". 

6.24 Converting S5 Programs to S7 Programs 

• When converting S5 programs to S7 programs, the special instructions for the 
CPUs in the SIMATIC S5-135U and SIMATIC S5-155U series are not taken into 
account. 

• The blocks in the library "FBLIB1" (visible in the SIMATIC Manager using File > 
Open > Libraries under "Standard Library V3.x") are only intended for 
converting existing S5 programs to S7 programs. They must not be used in new 
S7 programs. 

• When using the standard function blocks FC100 through FC111, the I/O 
addresses should be noted (see also the online help on these blocks). The 
update of the process image is dependent on the S7 CPU. If you assign a part 



I/O address (between 1 and 8) to the address, these addresses are not taken 
into account in the cyclic process-image update. 

• It is recommended that you select landscape format for printing out converted S5 
programs. With A4 portrait format, the characters at the end of a line may be 
printed in the next line. 

• You cannot convert S5 data to STEP 7 if the data are on write-protected media; 
for example, on read-only diskettes. 

Remedy: 

- First copy the S5 data to a directory which is not write-protected. 

- Then start the Converter and convert the copies. 

6.25 Converting TI Programs to S7 Programs 

The following points apply to the operating system used to date, under MS Windows 
Vista the TI converter is no longer installed.  

• A tool for converting TI programs to S7 programs is supplied. A manual in 
electronic form (English only) is supplied with this tool. 

• The TI converters can be started as usual from the Windows taskbar 
("Start/SIMATIC/STEP 7").  

• The library "TI-S7 Converting Blocks" (visible in the SIMATIC Manager via File > 
Open > Library Standard Library V3.x") contains the standard routines for use 
in converted TI programs. 

• If the function FC80 is called several times one after the other, the output 
variable "Q" may not be passed on to DB variables or local data. 

• When using the functions FC94 and FC95, the parameters IN and OUT cannot 
both point to data blocks at the same time. 

• When using the function FC104, the parameters TBL1 and TBL2 cannot point to 
data blocks. 

• The function FC102 can only be used with REAL data types (B#16#08). It will not 
work with INT or DINT data types.  

• The following TI systems are supported: 

- TI 405 

- TI 505 

6.26 Fault-tolerant Systems 

If you want to configure several redundant S7 connections to a fault-tolerant system, 
please take into account that is can take longer to establish all the connections than 
is permitted under the configured maximum communication delay. If this is the case, 
please increase the value "Maximum communications delay [ms]" in the 
fault-tolerant parameter properties of the CPU: 



6.27 Note on Using Foreign-Language Character Sets  

As of STEP 7 V5.3 SP2 in projects and libraries you can use foreign-language 
character sets that do not correspond to the language set in STEP 7. The 
prerequisite for this being that the desired character set is correspondingly installed 
in the operating system. For this, please observe Chapter "Using Foreign-Language 
Character Sets" in the Help for STEP 7 (refer to Chapter “Setting Up and Editing the 
Project "). 

In addition to the Help, the following information must also be observed: 

• The following foreign-language character sets have been tested for applicability 
under the MUI variations of the approved Windows operating systems: 

- Japanese 

- Chinese (simplified) 

- Korean 

- Russian 

- Greek 

Other languages are generally possible, however an unlimited applicability cannot 
be guaranteed. 

• The operating system option “Extend support of advanced text services to all 
programs” must not be enabled (for example, under Windows XP Control 
Panel/Regional Options and Language Settings/Details/Advanced). 

• The option “Upper Case/Lower Case” is offered in Search/Replace dialogues, 
even if the foreign language being used does not recognize a difference e.g. 
visual languages of Japanese and Chinese). 

• With input fields that only allow numerical inputs, only one-byte figures are 
permitted (relevant with visual languages like Japanese and Chinese). 

• When uploading a station, note that text that has been saved on a CPU can only 
be correctly displayed on Windows that has been installed in the same 
language. 

• Please note that CPU passwords may only contain ASCII characters. 

• In order to avoid display errors (e.g. with umlauts) on the interface, it is 
recommended to use STEP 7 with English as its interface language.  

• STEP 7 may not be installed in a directory the path of which includes characters 
that are not listed in the ASCII character set. 

• The PID control, S5/S7 converter and TI converter do not support 
foreign-language character sets. 

• Furthermore, foreign-language characters are not permitted in variable names in 
the LAD/FBD/STL editor. 

• When using optional packages, particularly language editors, you should ensure 
that these also support foreign-language input. Otherwise, the characters could 
become distorted when displayed or printed. If in doubt, items in the optional 
package should not be opened via the Recent File List, but via the open browser. 



• Please note that sources and blocks in the statement part use characters from 
the English character set exclusively (ASCII characters 0x2a - 0x7f). Especially 
blank spaces that are not entered in the specified character set are not 
interpreted as blank spaces and can lead to errors in the program. 

• Please note that when inserting external sources (function in SIMATIC 
Manager), the file name and directory name may only contain characters from 
the ASCII character set 0x2a - 0x7f. 

• Please note that for symbolic addressing, the symbolic names have to be written 
in quotation marks ("<symbolic name>"). 

• Language setting under MS Windows Vista, for example, Ultimate 

- Set the desire language with Control Panel > Region and Language Options 
> Formats. 

- Add the input language with Control Panel > Region and Language Options 
> Keyboards and Languages > Change Keyboard. 

- Set the desired display language with Control Panel > Region and Language 
Options > Management > System Locale. 

6.28 Note on the use of SIMATIC Logon 

Use the SIMATIC Logon Product, use at least V1.4 SP1 and note the information 
provided in this product. 

Additional notes: 

• Furthermore, a project password is available for opening projects. This is 
primarily for administrators, to transfer protected projects between the Windows 
domains, for example. Please note that when opening a project, a logged on 
user via Extras > SIMATIC Logon Services is entered in the project as an 
administrator, via a password. 

• STEP 7 supports the default settings of "Configure SIMATIC Logon". Changing 
these settings may result in unexpected problems with access-protected 
projects. 

• Note when using SIMATIC Logon that a user remains logged on even after 
closing the last project. The user is fully logged off with "SIMATIC Manager > 
Options > SIMATIC Logon Service --> Log off". 

6.29 Topology Editor 

With the topology determination, devices without IP address are assigned temporary 
IP addresses. These are maintained until power off of the respective device and may 
lead to address conflicts. 

Possible remedy: Switch the power off or assign another IP-address for the devices 
involved. 



6.30 Command Interface 

1. Please note that the command interface sequences will no longer be developed 
under MS Windows Vista since Visual Basic 6 cannot run under this operating 
system. 
Compiled command sequences will run under MS Windows Vista, however. 

2. Command interface: If you set the "VerbLogFile" property at the SIMATIC object, 
messages for the symbol import will be recorded in the log file and not in the file 
(as was previously the case). 

6.31 Special Characteristics of the MS Windows Vista 
Operating System 

Note that MS Windows Vista uses an advanced security design. 

As a result, access to protected areas of the file system, such as the "Program Files 
and "Windows" directories, are virtualized – your files are transparently redirected by 
the operating system to unprotected areas in this case. 

Note that the software in MS Windows Vista is no longer under "Start menu > 
SIMATIC"; it is now located under "Start menu > Program Files > Siemens 
Automation > SIMATIC". This was made necessary by the current architecture of 
MS Windows Vista. The information in the documentation and online help must be 
interpreted accordingly. 

Please note that Hibernate / Standby must not be used, especially under MS 
Windows Vista. 



7 Notes on Documentation 

Comprehensive documentation on STEP 7 is available to you in the online help for 
STEP 7. The "basic information" on STEP 7 in contained in the HTML-based 
"Help on STEP 7".  

The basic information and the reference information are both available to you as 
electronic manuals.  

This means that you have the choice between calling information exclusively from 
the online help or printing out individual chapters in order to read this information 
later on.  

Help on STEP 7 
You can activate the "Help on STEP 7" using the menu command Help > Contents 
in all STEP 7 applications. The "Help on STEP 7" provides you with the basic 
information you need for working with the STEP 7 software. It offers you the following 
search options: 

• From the contents page, you can navigate through the different configuration 
tasks you need to carry out 

• The "Objects" command button at the top margin of the help window are used to 
select the functions which can be executed after an object has been selected.  

• The "Index" tab supports you when searching for specific topics 

• The "Find" tab supports you when searching for individual terms. 

All the jumps in the "Help on STEP 7" appear in blue. As soon as one of these jumps 
in activated, it changes color.  

Using the buttons at the top of the help window, you can comfortably call up help for 
the STEP 7 objects as well as the STEP 7 glossary.  

Application help 
The "Help on STEP 7" is complemented by application helps, for example, the Help 
on SIMATIC Manager. Here you can find information, for example, on the menu 
commands, dialog boxes, and keyboard controls used in this application, as well as 
other application-specific information. 

All the jumps within these application helps appear in green. Jumps to the "Help on 
STEP 7" appear in blue. You can also call the "Help on STEP 7" using the button at 
the top of the help window of the same name. 

You can call the application help by selecting one of the menu commands Help > 
Context-Sensitive Help, Help > Introduction, or Help > Getting Started or by 
selecting an object and pressing the F1 key.  

Printing the help 
The print function is available for both the "Help on STEP 7" and the application help. 
The scope of the information printed varies depending on whether you have selected 
a single topic or a whole book in the contents page. 



Manuals 
The manuals for STEP 7 can be accessed for example, under Windows XP, at Start 
> SIMATIC > S7 Manuals. They can be displayed and printed with Acrobat Reader, 
which is supplied with the STEP 7 software.  

Due to the editorial deadline necessary in the creation of the product manuals, there 
may be an occasional slight difference between their content and that of the online 
help. 

Up-to-date information: 
Contrary to the information about operating systems in the online help, STEP 7 V5.4 
SP3 has also been approved for MS Windows Vista Business and Ultimate. 

When reading references to the Start menu, keep in mind the form of the Start menu 
differs under the various operating systems. 



8 Software with OSS Components 

For Resellers: In order to avoid infringements of the license conditions by the 
reseller or the buyer these instructions and license conditions and the 
enclosed CD have to be forwarded to the buyers. 

Copyrights 
 

Name Copyright Owner or License 

STEP 7 Copyright © 2003-2007, Siemens AG, all rights 
reserved 

Automation License Manager Copyright © 2007, Siemens AG, all rights reserved 
Adobe Reader Copyright © 2007, Adobe, all rights reserved 
.Net Framework V1.1 Copyright © 2003, Microsoft Corporation, all rights 

reserved 
PKZip  Copyright © 2007, PKWare, Inc. 
SQL Anywhere Copyright © 1989-2004, Sybase Inc., all rights 

reserved 
winhlp32;  
Windows-KB917607 

Copyright © 2007, Microsoft Corporation, all rights 
reserved 

btrieve 6.15.2 Copyright © 1989-1994, Btrieve Technologies, Inc. 
Formula One Library 2.0.3.6 Copyright © 1993-1994, Visual Tools Inc. 
ObjGrid DLL Shared Library 
6.1.0.0 

Copyright © 1995-1998 ClassWorks 

Objective Toolkit DLL Copyright © 1998 Stingray Software Inc. 
ARJ 2.50a Copyright © 1990-1995 ARJ Software / Robert K Jung 
Codebase Copyright © 1990-1995 Sequiter Software Inc., all 

rights reserved 
Installshield Install Driver V8 Copyright © 1990-2001 InstallShield Software 

Corporation 
Installshield Install Driver V11 Copyright © 2005 Macrovision Corporation 
StopCopy Copyright © 1999, 2001 BBI Computer Systems, Inc. 

 



9 Siemens Licensing Conditions 
General License Conditions for Software Products for Automation and 
Drives 
1. Supply of Software to Licensee and Granting of Rights to use the Software 

1.1 These General License Conditions shall exclusively apply to the delivery of 
Software for Automation and Drives to the Licensee. General terms and conditions 
of the Licensee shall apply only where expressly accepted in writing by us. The 
scope of delivery of the Software shall be determined by the congruent mutual 
written declarations of both parties. We shall grant the Licensee rights to use the 
software specified in the Confirmation of Order or, if the Licensee does not receive a 
Confirmation of Order, the software specified in the certificate of license or that 
specified in the Software Product Sheet, if the Licensee is instead submitted a 
Software Product Sheet (hereinafter referred to as "SW"). The certificate of license 
and the Software Product Sheet shall be collectively referred to as "CoL" hereinafter. 
The Licensee shall be submitted the CoL when the SW is supplied or in conjunction 
with the delivery bill. The way in which the SW is supplied is also derived directly 
from the Confirmation of Order or from the SW purchase order number contained in 
the Confirmation of Order, in conjunction with the associated order data of our 
catalog valid at the time of the Confirmation of Order (hereinafter collectively referred 
to as "Order Data"), or from the CoL. If the Licensee does not receive a data 
medium, it shall be authorized to copy the SW already available to it to the extent 
necessary to exercise the rights to use the SW granted to it. The aforesaid shall 
apply, mutatis mutandis, to electronic supply of the software (downloading). Where 
reference is made to the Order Data or the CoL in these General License Conditions, 
the reference to the CoL is of significance if the Licensee has not received a 
Confirmation of Order. In any case, the data contained in the Order Data is also 
contained in the CoL. 

1.2 The Documentation relating to the SW (hereinafter referred to as 
"Documentation") shall be purchased separately, unless either the Order Data or 
CoL contain a stipulation stating that it belongs to the scope of delivery. If the 
Licensee is authorized to copy the SW in accordance with Clause 1.1, this shall also 
apply to the Documentation provided that it is included in the scope of delivery. 

1.3 In the event that we submit a License Key to the Licensee, which unlocks the SW 
(hereinafter referred to as "License Key"), this License Key must also be installed. 

1.4 The rights granted to the Licensee with respect to the SW are based on the 
License Type (see Section 2) and the Software Type (see Section 3). The license 
and Software Types are detailed in the Order Data or CoL. If the SW is supplied 
electronically or if copying rights are granted for it, the rights and duties specified in 
these General License Conditions shall apply to the legitimately generated copies. 

1.5 If the Licensee is legitimately in possession of a previous SW version/release 
(hereinafter referred to as "Previous Version"), the Licensee shall be authorized to 
exercise the rights to use the SW granted to it either with respect to the SW or - if this 
is intended from a technical point of view - to the Previous Version, at its own 
discretion (downgrading). If the SW is an Upgrade or PowerPack in accordance with 
Section 4, Section 4 shall apply additionally. 



1.6 In case the Licensee obtains only the data media but no license as per the Order 
Data or the CoL, any use of the SW by the Licensee is subject to the acquisition of a 
license according to Section 2. Up to the acquisition of the license, the Licensee is 
not entitled to supply the SW to third parties. 

1.7 Insofar as the SW contains Open Source Software (hereinafter referred to as 
"OSS") the OSS is listed in the readme file of the SW. The Licensee is entitled to use 
the OSS in accordance with the respective license conditions of the OSS. The 
license conditions are provided on the same data carrier as the SW. The license 
conditions of the respective OSS shall prevail these General License Conditions with 
respect to the OSS. If the license conditions of the OSS require the distribution of the 
source code of such OSS we shall provide such source code on request against 
payment of the shipping and handling charges. 

1.8 The SW may be licensed software, i.e. software which has not been developed 
by us itself but which has been licensed to us by a third party (hereinafter referred to 
as the "Licensor"), e.g. Microsoft Licensing Inc. In the event that the Licensee is then 
forwarded the terms and conditions stipulated by the relevant Licensor together with 
the SW, such terms and conditions shall apply with respect to the Licensor's liability 
vis-à-vis the Licensee. Our own liability vis-à-vis the Licensee shall be governed by 
these General License Conditions. 

2. License Type 

Depending on the License Type, the Licensee shall be granted the following rights to 
the SW: 

2.1 Single License (One Off License, Copy License) 

The term "One Off License" or "Copy License" which may be used in the Software 
Product Sheet corresponds to the term "Single License". The following regulation 
shall apply to the full scope of the One Off License / Copy License. The Licensee 
shall be granted the non-exclusive right, transferable in accordance with Clause 5.3 
and valid for an unlimited period of time, to install the SW on one (1) hardware device 
and to utilize the SW thus installed in the manner specified in the Order Data or CoL 
(see "Type of Use"). 

2.2 Floating License 

The Licensee shall be granted the non-exclusive right, transferable in accordance 
with Clause 5.3 and valid for an unlimited period of time, to install the SW on any 
desired number of the Licensee's hardware devices. The number of persons 
permitted to utilize the SW at the same time ("Users") can be derived from the Order 
Data or CoL (see "Type of Use). 

2.3 Rental License 

The Licensee shall be granted the non-exclusive right, transferable in accordance 
with Clause 5.3 and limited in time as stipulated in the Order Data or CoL (see "Type 
of Use"), to install the SW on one (1) hardware device and to use it. If the period of 
use is specified in hours, the usage decisive for the calculation of the time limit 
commences with the software start-up and finishes with its shut-down. If the period 
of usage is specified in days, weeks or months, the specified period, which 
commences in conjunction with the first SW start-up, shall apply independently of the 
actual time of usage. 

2.4 Trial License 



The Licensee shall be granted the non-exclusive and non-transferable right to install 
the SW on one (1) hardware device and to use it for validation purposes in the 
manner specified in the Order Data or CoL (see "Type of Use"). The period of usage 
is limited to 14 days and commences with the SW start-up, unless a different period 
of usage is specified in the Order Data or CoL. 

2.5 Factory License 

The Licensee shall be granted the non-exclusive right, transferable in accordance 
with Clause 5.3 and valid for an unlimited period of time, to install and use the SW in 
one (1) operating site of the Licensee. The number of devices on which the software 
can be installed and used at any one time can be derived from the Order Data or CoL 
(see "Type of Use). An operating site is defined by its address. Operating sites with 
varying addresses are considered different operating sites in terms of these General 
License Conditions, unless otherwise agreed in the Order Data or CoL. The 
Licensee shall be granted the right to permanently use the software in another 
operating site, if he removes the software beforehand from all devices of the 
previous operating site and completely ceases to use the software at the previous 
operating site. 

 

3. Software Type 

If the Software Type is not specified in the Order Data or CoL, the rights specified in 
Clause 3.2 (Runtime Software) shall apply to the SW. 

3.1 Engineering Software (hereinafter referred to as "E-SW") 

In the event that the Licensee uses E-SW to generate its own programs or data 
containing parts of the E-SW, the Licensee shall have the right, without having to pay 
any license fee, to copy and to use these parts of the E-SW as a part of its own 
programs or data, or to supply them to third parties for use. In the event that such 
parts are supplied to third parties for use, these parties shall be bound in writing to 
comply with stipulations corresponding to those in Clauses 5.1 and 5.2 with respect 
to the above parts of the E-SW. 

3.2 Runtime Software (hereinafter referred to as "R-SW") 

If the Licensee incorporates R-SW or any parts thereof into its own programs or data, 
it shall purchase a license with respect to the R-SW each time it installs or copies - 
depending on what is done first - its own programs or data containing R-SW or parts 
thereof, in accordance with the relevant intended Type of Use and on the basis of the 
Siemens catalog valid at that time. In the event that the Licensee supplies the 
specified programs or data to third parties for their use, these parties shall be bound 
in writing to adhere to stipulations corresponding to those in Section 5, with respect 
to the R-SW parts contained therein. The aforesaid shall not affect the Licensee's 
obligation to purchase a license for the R-SW if the R-SW original is copied. If the 
R-SW contains tools for parameterization/configuration and extended rights have 
been granted in this regard, this will be detailed in the readme file of the R-SW. 

 

4. Upgrade and PowerPack 

If it is apparent from the Order Data or CoL, e.g. by the addition "PowerPack" or 
"Upgrade" after the SW product name, that the SW is an upgrade for another 
software item (hereinafter referred to as "Source License"), the Licensee shall also 
have the rights to use the SW granted to it with respect to the Source License as 



soon as this has been upgraded with the Upgrade/PowerPack. The rights originally 
granted to the Licensee to use the Source License end in conjunction with the 
upgrade measure. However, the Licensee is entitled to undo the upgrading 
(downgrading) - if this is intended from a technical point of view - and to exercise the 
rights to use the SW granted to it with respect to the Source Version in accordance 
with Clause 1.5. 

 

5. Further Rights and Duties of the Licensee 

5.1 Unless a stipulation to the contrary relating to a specific number of copies is 
contained on the data medium or in the readme file of the SW, the Licensee may 
generate an appropriate number of copies of every item of SW which it is authorized 
to use in accordance with these General License Conditions, where such copies 
shall be used exclusively for data backup purposes. Furthermore the Licensee may 
only copy the SW if and insofar as it has been granted copying rights by us in writing. 

5.2 The Licensee shall not be entitled to modify, decompile or reverse engineer the 
SW. Nor may it extract any individual parts unless this is permitted by mandatory 
copyright law. Furthermore, the Licensee shall not be entitled to remove any 
alphanumeric identifiers, trademarks or copyright notices from the SW or the data 
medium and, insofar as it is entitled to make copies of the SW, shall copy them 
without alteration. The aforementioned regulation shall apply accordingly to the 
Documentation supplied in accordance with Section 1. 

5.3 The Licensee shall be entitled to transfer the right to use the SW granted to it to a 
third party, provided that it concludes a written agreement with the third party in 
conformance with all of the conditions contained in this Section 5 and on the proviso 
that it does not retain any copies of the SW. If the Licensee has received a License 
Key for the SW, this key shall be supplied to the third party together with the SW. 
Furthermore, the third party shall be submitted the CoL together with these General 
License Conditions. The Licensee shall submit the CoL received for the SW to us at 
any time, if requested. 

5.4 If the SW is a PowerPack or an Upgrade, the Licensee shall keep the certificate 
of license or Software Product Sheet of the Source License and submit it to us at any 
time, if requested, together with the CoL for the SW. In the event that the Licensee 
transfers its right to use the PowerPack SW or Upgrade SW in accordance with 
Clause 5.3, it shall also submit the certificate of license or Software Product Sheet of 
the Source License to the third party. 

5.5 If the Licensee receives a data medium which, in addition to the SW, contains 
further software products which are released for use, then it shall have the right to 
use these released software products exclusively for validation purposes, for a 
limited period of time and free of charge. The period of use shall be limited to 14 
days, commencing with the first start-up of the relevant software program unless a 
different period is specified e.g. in the readme file of the relevant software product. 
These software products supplied exclusively for validation purposes shall be 
governed, mutatis mutandis, by the stipulations contained in these General License 
Conditions. The Licensee shall not be authorized to pass on these software products 
separately, i.e. without the SW, to a third party. 

In other respects, the terms of the purchase contract shall apply, unless an explicit 
agreement is subsequently made for the open source software. 



10 Licensing Conditions for Commercial 
Third-part Software 

10.1 Adobe Reader 

ADOBE SYSTEMS INCORPORATED 

SOFTWARE LICENSE AGREEMENT 

NOTICE TO USER: PLEASE READ THIS CONTRACT CAREFULLY. BY USING, 
COPYING OR DISTRIBUTING ALL OR ANY PORTION OF THE ADOBE 
SOFTWARE ("SOFTWARE") YOU ACCEPT ALL THE TERMS AND CONDITIONS 
OF THIS AGREEMENT, INCLUDING, IN PARTICULAR THE LIMITATIONS ON: 
USE CONTAINED IN SECTION 2; TRANSFERABILITY IN SECTION 4; 
WARRANTY IN SECTION 7; AND LIABILITY IN SECTION 8. YOU AGREE THAT 
THIS AGREEMENT IS ENFORCEABLE LIKE ANY WRITTEN NEGOTIATED 
AGREEMENT SIGNED BY YOU. 

THISAGREEMENT IS ENFORCEABLE AGAINST YOU AND ANY LEGAL ENTITY 
THAT OBTAINED THE SOFTWARE AND ON WHOSE BEHALF IT IS USED. 

IF YOU DO NOT AGREE, DO NOT USE THIS SOFTWARE. 

Adobe and its suppliers own all intellectual property in the Software. Adobe permits 
you to Use the Software only in accordance with the terms of this Agreement. Use of 
some third party materials included in the Software may be subject to other terms 
and conditions typically found in a separate license agreement, a “Read Me” file 
located near such materials or in the “Third Party Software Notices and/or Additional 
Terms and Conditions” found at http://www.adobe.com/go/thirdparty 

1. Definitions. "Software" means (a) all of the contents of the files (provided either by 
electronic download, on physical media or any other method of distribution), disk(s), 
CD-ROM(s) or other media with which this Agreement is provided, including but not 
limited to (i) Adobe or third party computer information or software, including the 
Adobe Reader® ("Adobe Reader"), Adobe Flash® Player, Shockwave® Player and 
Authorware® Player (collectively, the Flash, Shockwave and Authorware players, 
are the "Web Players"); (ii) related explanatory written materials or files 
("Documentation"); and (iii) fonts; and (b) upgrades, modified versions, updates, 
additions, and copies of the Software, if any, licensed to you by Adobe (collectively, 
"Updates"). "Use" or "Using" means to access, install, download, copy, or otherwise 
benefit from using the functionality of the Software in accordance with the 
Documentation. "Permitted Number" means one (1) unless otherwise indicated 
under a valid license (e.g., volume license) granted by Adobe. "Computer" means an 
electronic device that accepts information in digital or similar form and manipulates it 
for a specific result based on a sequence of instructions. "Adobe" means Adobe 
Systems Incorporated, a Delaware corporation, 345 Park Avenue, San Jose, 
California 95110, if subsection 9 (a) of this Agreement applies; otherwise it means 
Adobe Systems Software Ireland Limited, Unit 3100, Lake Drive, City West Campus, 
Saggart D24, Republic of Ireland, a company organized under the laws of Ireland 
and an affiliate and licensee of Adobe Systems Incorporated. 



2. Software License. If you obtained the Software from Adobe or one of its 
authorized licensees, and subject to your compliance with the terms of this 
agreement (this "Agreement"), including the restrictions in Section 3, Adobe grants 
to you a non-exclusive license to Use the Software for the purposes described in the 
Documentation as follows. 

2.1 General Use. You may install and Use a copy of the Software on your compatible 
Computer, up to the Permitted Number of computers. The Software may not be 
shared, installed or used concurrently on different computers. See Section 3 for 
important restrictions on the Use of Adobe Reader and Web Players. 

2.2 Server Use and Distribution. 

2.2.1 You may install one copy of the Adobe Reader on a computer file server within 
your internal network for the sole and exclusive purpose of (a) using the Software 
(from an unlimited number of client computers on your internal network) via (i) the 
Network File System (NFS) for UNIX versions of the Software or (ii) Windows 
Terminal Services and (b) allowing for printing within your internal network. Unless 
otherwise expressly permitted hereunder, no other server or network use of the 
Software is permitted, including but not limited to use of the Software (i) either 
directly or through commands, data or instructions from or to another computer or (ii) 
for internal network, internet or web hosting services. 

2.2.2 For information on how to distribute the Software on tangible media or through 
an internal network please refer to the sections entitled "How to Distribute Adobe 
Reader" at  
http://www.adobe.com/products/acrobat/distribute.html; or  
"Distribute Macromedia Web Players" at http://www.adobe.com/licensing 

2.3 Backup Copy. You may make one backup copy of the Software, provided your 
backup copy is not installed or used on any Computer. You may not transfer the 
rights to a backup copy unless you transfer all rights in the Software as provided 
under Section 4. 

2.4 Portable or Home Computer Use. If and only if the Software is Adobe Reader, in 
addition to the single copy permitted under Sections 2.1 and 2.2, the primary user of 
the Computer on which the Software is installed may make a second copy of the 
Software for his or her exclusive Use on either a portable Computer or a Computer 
located at his or her home, provided the Software on the portable or home Computer 
is not used at the same time as the Software on the primary computer. 

2.5 No Modification. 

2.5.1 You may not modify, adapt, translate or create derivative works based upon 
the Software. You may not reverse engineer, decompile, disassemble or otherwise 
attempt to discover the source code of the Software except to the extent you may be 
expressly permitted to decompile under applicable law, it is essential to do so in 
order to achieve operability of the Software with another software program, and you 
have first requested Adobe to provide the information necessary to achieve such 
operability and Adobe has not made such information available. Adobe has the right 
to impose reasonable conditions and to request a reasonable fee before providing 
such information. Any such information supplied by Adobe and any information 
obtained by you by such permitted decompilation may only be used by you for the 
purpose described herein and may not be disclosed to any third party or used to 
create any software which is substantially similar to the expression of the Software. 
Requests for information should be directed to the Adobe Customer Support 
Department. 



2.5.2 As an exception to the above, you may customize or extend the functionality of 
the installer for the Adobe Reader as specifically allowed by instructions found at 
http://www.adobe.com/support or http://www.adobe.com/go/reader_developer 
(e.g., installation of additional plug-in and help files). You may not otherwise alter or 
modify the Software or create a new installer for the Software. The Adobe Reader is 
licensed and distributed by Adobe for viewing, distributing and sharing PDF files. 

2.6 Third Party Website Access. The Software may allow you to access third party 
websites ("Third Party Sites"). Your access to and use of any Third Party Sites, 
including any goods, services or information made available from such sites, is 
governed by the terms and conditions found at each Third Party Site, if any. Third 
Party Sites are not owned or operated by Adobe. YOUR USE OF THIRD PARTY 
SITES IS AT YOUR OWN RISK. ADOBE MAKES NO WARRANTIES, 
CONDITIONS, INDEMNITIES, REPRESENTATIONS OR TERMS, EXPRESS OR 
IMPLIED, WHETHER BY STATUTE, COMMON LAW, CUSTOM, USAGE OR 
OTHERWISE AS TO ANY OTHER MATTERS, INCLUDING BUT NOT LIMITED TO 
NON-INFRINGEMENT OF THIRD PARTY RIGHTS, TITLE, INTEGRATION, 
ACCURACY, SECURITY, AVAILABILITY, SATISFACTORY QUALITY, 
MERCHANTABILITYOR FITNESS FOR ANY PARTICULAR PURPOSE WITH 
RESPECT TO THE THIRD PARTY SITES. 

 

2.7 Certified Documents. 

2.7.1 Certified Documents and CD Services. The Software may allow you to validate 
Certified Documents. A "Certified Document" or “CD” is a PDF file that has been 
digitally signed using (a) a certificate and (b) a “private” encryption key that 
corresponds to the “public” key in the certificate. Validation of a CD requires CD 
Services from the CD Service Provider that issued the certificate. 

“CD Service Provider” is an independent third party service vendor listed at 

http://www.adobe.com/security/partners_cds.html “CD Services” are services 
provided by CD Service Providers, including without limitation (i) certificates issued 
by such CD Service Provider for use with the Software’s CD feature set, (ii) services 
related to issuance of certificates, and (iii) other services related to certificates, 
including without limitation verification services. 

2.7.2 CD Service Providers. Although the Software may provide validation features, 
Adobe does not supply the necessary CD Services required to use these features. 
Purchasing, availability and responsibility for the CD Services are between you and 
the CD Service Provider. Before you rely upon any CD, any digital signature applied 
thereto, and/or any related CD Services, you must first review and agree to the 
applicable Issuer Statement and this Agreement. “Issuer Statement” means the 
terms and conditions under which each CD Service Provider offers CD Services (see 
the links on http://www.adobe.com/security/partners_cds.html),  
including for example any subscriber agreements, relying party agreements, 
certificate policies and practice statements, and Section 2.7 of this Agreement. By 
validating a CD using CD Services, you acknowledge and agree that (a) the 
certificate used to digitally sign a CD may be revoked at the time of verification, 
making the digital signature on the CD appear valid when in fact it is not, (b) the 
security or integrity of a CD may be compromised due to an act or omission by the 
signer of the CD, the applicable CD Service Provider, or any other third party and (c) 
you must read, understand, and be bound by the applicable Issuer Statement. 

 



2.7.3 Warranty Disclaimer. CD Service Providers offer CD Services solely in 
accordance with the applicable Issuer Statement. ACCESS TO THE CD SERVICES 
THROUGH THE USE OF THE SOFTWARE IS MADE AVAILABLE ON AN “AS IS” 
BASIS ONLY AND WITHOUT ANY WARRANTY OR INDEMNITY OF ANY KIND 
(EXCEPT AS SUPPLIED BY A CD SERVICES PROVIDER IN ITS ISSUER 
STATEMENT). ADOBE AND EACH CD SERVICE PROVIDER (EXCEPT AS 
EXPRESSLY PROVIDED IN ITS ISSUER STATEMENT) MAKE NO 
WARRANTIES, CONDITIONS, INDEMNITIES, REPRESENTATIONS OR TERMS, 
EXPRESS OR IMPLIED, WHETHER BY STATUTE, COMMON LAW, CUSTOM, 
USAGE OR OTHERWISE AS TO ANY OTHER MATTERS, INCLUDING BUT NOT 
LIMITED TO NON-INFRINGEMENT OF THIRD PARTY RIGHTS, TITLE, 
INTEGRATION, ACCURACY, SECURITY, AVAILABILITY, SATISFACTORY 
QUALITY, MERCHANTABILITY OR FITNESS FOR ANY PARTICULAR PURPOSE 
WITH RESPECT TO THE CD SERVICES. 

2.7.4 Indemnity. You agree to hold Adobe and any applicable CD Service Provider 
(except as expressly provided in its Issuer Statement) harmless from any and all 
liabilities, losses, actions, damages, or claims (including all reasonable expenses, 
costs, and attorneys fees) arising out of or relating to any use of, or reliance on, any 
CD Service, including, without limitation (a) reliance on an expired or revoked 
certificate, (b) improper verification of a certificate, (c) use of a certificate other than 
as permitted by any applicable Issuer Statement, this Agreement or applicable law; 
(d) failure to exercise reasonable judgment under the circumstances in relying on the 
CD Services or (e) failure to perform any of the obligations as required in an 
applicable Issuer Statement. 

2.7.5 Limit of Liability. UNDER NO CIRCUMSTANCES WILL ADOBE OR ANY CD 
SERVICE PROVIDER (EXCEPT AS EXPRESSLY SET FORTH IN ITS ISSUER 
STATEMENT) BE LIABLE TO YOU, OR ANY OTHER PERSON OR ENTITY, FOR 
ANY LOSS OF USE, REVENUE OR PROFIT, LOST OR DAMAGED DATA, OR 
OTHER COMMERCIAL OR ECONOMIC LOSS OR FOR ANY DIRECT, INDIRECT, 
INCIDENTAL, SPECIAL, STATUTORY, PUNITIVE, EXEMPLARY OR 
CONSEQUENTIAL DAMAGES WHATSOEVER RELATED TO YOUR USE OR 
RELIANCE UPON CD SERVICES, EVEN IF ADVISED OF THE POSSIBILITY OF 
SUCH DAMAGES OR IF SUCH DAMAGES ARE FORESEEABLE. THIS 
LIMITATION SHALL APPLY EVEN IN THE EVENT OF A FUNDAMENTAL OR 
MATERIAL BREACH OR A BREACH OF THE FUNDAMENTAL OR 
MATERIALTERMS OF THIS AGREEMENT. 

2.7.6 Third Party Beneficiaries. You agree that any CD Service Provider you utilize 
shall be a third party beneficiary with respect to this Section 2.7 of this Agreement, 
and that such CD Service Provider shall have the right to enforce such provisions in 
its own name as if the CD Service Provider were Adobe. 

3. Restrictions. 

3.1 Web Player Prohibited Devices. You may not Use any Web Player on any 
non-PC device or with any embedded or device version of any operating system. For 
the avoidance of doubt, and by example only, you may not use a Web Player on any 
(a) mobile devices, set top boxes (STB), handhelds, phones, web pads, tablets and 
Tablet PCs that are not running Windows XP Tablet PC Edition, game consoles, 
TVs, DVD players, media centers (excluding Windows XP Media Center Edition and 
its successors), electronic billboards or other digital signage, internet appliances or 
other internet-connected devices, PDAs, medical devices, ATMs, telematic devices, 
gaming machines, home automation systems, kiosks, remote control devices, or any 



other consumer electronics device, (b) operator-based mobile, cable, satellite, or 
television systems or (c) other closed system devices. 

3.2 Notices. You shall not copy the Software except as set forth in Section 2. Any 
copy of the Software that you make must contain the same copyright and other 
proprietary notices that appear on or in the Software. 

3.3 Document Features. The Software may contain features and functionality (the 
“Document Features”) that appear disabled or “grayed out.” These Document 
Features will only activate when opening a PDF document that was created using 
corresponding enabling technology available only from Adobe (“Keys”). You agree 
not to access, or attempt to access, disabled Document Features or otherwise 
circumvent the permissions that control activation of such Document Features. You 
may only use the Document Features with PDF documents that have been enabled 
using Keys obtained under a valid license from Adobe. No other use is permitted 

3.4 Adobe Reader Restrictions. You are not authorized to integrate or use the Adobe 
Reader with any other software, plug-in or enhancement that uses or relies upon the 
Adobe Reader when converting or transforming PDF files into other file formats (e.g., 
a PDF file into a TIFF, JPEG, or SVG file). You are not authorized to integrate or use 
the Adobe Reader with any plug-in software not developed in accordance with the 
Adobe Integration Key License Agreement. Further, you are not permitted to 
integrate or use the Adobe Reader with other software, or access PDF files that 
contain instructions (e.g., JavaScript), in order to (a) save data locally (on the same 
Computer), (b) create a file that contains data (e.g., an XML or comments file) or (c) 
save modifications to a PDF file, except when such saving or creation is allowed 
through the use of Document Feature(s) enabled by Adobe. 

 

4. Transfer. You may not rent, lease, sublicense, assign or transfer your rights in the 
Software, or authorize all or any portion of the Software to be copied onto another 
user's Computer except as may be expressly permitted herein. You may, however, 
transfer all your rights to Use the Software to another person or legal entity provided 
that: (a) you also transfer (i) this Agreement, and (ii) the Software and all other 
software or hardware bundled or pre-installed with the Software, including all copies, 
Updates and prior versions, to such person or entity, (b) you retain no copies, 
including backups and copies stored on a Computer, and (c) the receiving party 
accepts the terms and conditions of this Agreement and any other terms and 
conditions upon which you legally purchased a license to the Software. 
Notwithstanding the foregoing, you may not transfer education, pre-release, or not 
for resale copies of the Software. 

5. Intellectual Property Ownership, Copyright Protection. The Software and any 
authorized copies that you make are the intellectual property of and are owned by 
Adobe Systems Incorporated and its suppliers. The structure, organization and code 
of the Software are the valuable trade secrets and confidential information of Adobe 
Systems Incorporated and its suppliers. The Software is protected by law, including 
without limitation the copyright laws of the United States and other countries, and by 
international treaty provisions. Except as expressly stated herein, this Agreement 
does not grant you any intellectual property rights in the Software and all rights not 
expressly granted are reserved by Adobe and its suppliers. 

6. Updates. If the Software is an Update to a previous version of the Software, you 
must possess a valid license to such previous version in order to Use such Update. 
All Updates are provided to you on a license exchange basis. You agree that by 



Using an Update you voluntarily terminate your right to use any previous version of 
the Software. As an exception, you may continue to Use previous versions of the 
Software on your Computer after you Use the Update but only to assist you in the 
transition to the Update, provided that: (a) the Update and the previous versions are 
installed on the same computer; (b) the previous versions or copies thereof are not 
transferred to another party or Computer unless all copies of the Update are also 
transferred to such party or Computer; and (c) you acknowledge that any obligation 
Adobe may have to support the previous versions of the Software may be ended 
upon availability of the Update. 

7. NO WARRANTY. The Software is being delivered to you "AS IS" and Adobe 
makes no warranty as to its use or performance. Adobe provides no technical 
support, warranties or remedies for the Software. ADOBE AND ITS SUPPLIERS DO 
NOT AND CANNOT WARRANT THE PERFORMANCE OR RESULTS YOU MAY 
OBTAIN BY USING THE SOFTWARE. EXCEPT FOR ANY WARRANTY, 
CONDITION, REPRESENTATION OR TERM TO THE EXTENT TO WHICH THE 
SAME CANNOT OR MAY NOT BE EXCLUDED OR LIMITED BY LAW 
APPLICABLE TO YOU IN YOUR JURISDICTION, ADOBE AND ITS SUPPLIERS 
MAKE NO WARRANTIES CONDITIONS, REPRESENTATIONS, OR TERMS 
(EXPRESS OR IMPLIED WHETHER BY STATUTE, COMMON LAW, CUSTOM, 
USAGE OR OTHERWISE) AS TO ANY MATTER INCLUDING WITHOUT 
LIMITATION NONINFRINGEMENT OF THIRD PARTY RIGHTS, 
MERCHANTABILITY, INTEGRATION, SATISFACTORY QUALITY, OR FITNESS 
FOR ANY PARTICULAR PURPOSE. The provisions of Section 7 and Section 8 
shall survive the termination of this Agreement, howsoever caused, but this shall not 
imply or create any continued right to Use the Software after termination of this 
Agreement. 

8. LIMITATION OF LIABILITY. 

IN NO EVENT WILL ADOBE OR ITS SUPPLIERS BE LIABLE TO YOU FOR ANY 
DAMAGES, CLAIMS OR COSTS WHATSOEVER OR ANY CONSEQUENTIAL, 
INDIRECT, INCIDENTAL DAMAGES, OR ANY LOST PROFITS OR LOST 
SAVINGS, EVEN IF AN ADOBE REPRESENTATIVE HAS BEEN ADVISED OF 
THE POSSIBILITY OF SUCH LOSS, DAMAGES, CLAIMS OR COSTS OR FOR 
ANY CLAIM BY ANY THIRD PARTY. THE FOREGOING LIMITATIONS AND 
EXCLUSIONS APPLY TO THE EXTENT PERMITTED BY APPLICABLE LAW IN 
YOUR JURISDICTION. ADOBE’S AGGREGATE LIABILITY AND THAT OF ITS 
SUPPLIERS UNDER OR IN CONNECTION WITH THIS AGREEMENT SHALL BE 
LIMITED TO THE AMOUNT PAID FOR THE SOFTWARE, IF ANY. Nothing 
contained in this Agreement limits Adobe’s liability to you in the event of death or 
personal injury resulting from Adobe’s negligence or for the tort of deceit (fraud). 
Adobe is acting on behalf of its suppliers for the purpose of disclaiming, excluding 
and/or limiting obligations, warranties and liability as provided in this Agreement, but 
in no other respects and for no other purpose. For further information, please see the 
jurisdiction specific information at the end of this Agreement, if any, or contact 
Adobe’s Customer Support Department. 

9. Export Rules. You agree that the Software will not be shipped, transferred or 
exported into any country or used in any manner prohibited by the United States 
Export Administration Act or any other export laws, restrictions or regulations 
(collectively the "Export Laws"). In addition, if the Software is identified as export 
controlled items under the Export Laws, you represent and warrant that you are not a 
citizen, or otherwise located within, an embargoed nation (including without limitation 
Iran, Syria, Sudan, Libya, Cuba, and North Korea) and that you are not otherwise 



prohibited under the Export Laws from receiving the Software. All rights to Use the 
Software are granted on condition that such rights are forfeited if you fail to comply 
with the terms of this Agreement. 

10. Governing Law. This Agreement will be governed by and construed in 
accordance with the substantive laws in force: (a) in the State of California, if a 
license to the Software is obtained when you are in the United States, Canada, or 
Mexico; or (b) in Japan, if a license to the Software is obtained when you are in 
Japan, China, Korea, or other Southeast Asian country where all official languages 
are written in either an ideographic script (e.g., hanzi, kanji, or hanja), and/or other 
script based upon or similar in structure to an ideographic script, such as hangul or 
kana; or (c) England, if a license to the Software is purchased when you are in any 
other jurisdiction not described above. The respective courts of Santa Clara County, 
California when California law applies, Tokyo District Court in Japan, when 
Japanese law applies, and the competent courts of England, when the law of 
England applies, shall each have non-exclusive jurisdiction over all disputes relating 
to this Agreement. This Agreement will not be governed by the conflict of law rules of 
any jurisdiction or the United Nations Convention on Contracts for the International 
Sale of Goods, the application of which is expressly excluded. 

11. General Provisions. If any part of this Agreement is found void and 
unenforceable, it will not affect the validity of the balance of this Agreement, which 
shall remain valid and enforceable according to its terms. This Agreement shall not 
prejudice the statutory rights of any party dealing as a consumer. This Agreement 
may only be modified by a writing signed by an authorized officer of Adobe. Updates 
may be licensed to you by Adobe with additional or different terms. This is the entire 
agreement between Adobe and you relating to the Software and it supersedes any 
prior representations, discussions, undertakings, communications or advertising 
relating to the Software. 

12. Notice to U.S. Government End Users. The Software and Documentation are 
"Commercial Items," as that term is defined at 48 C.F.R. §2.101, consisting of 
"Commercial Computer Software" and "Commercial Computer Software 
Documentation," as such terms are used in 48 C.F.R. §12.212 or 48 C.F.R. 
§227.7202, as applicable. Consistent with 48 C.F.R. §12.212 or 48 C.F.R. 
§§227.7202-1 through 227.7202-4, as applicable, the Commercial Computer 
Software and Commercial Computer Software Documentation are being licensed to 
U.S. Government end users (a) only as Commercial Items and (b) with only those 
rights as are granted to all other end users pursuant to the terms and conditions 
herein. Unpublished-rights reserved under the copyright laws of the United States. 
Adobe Systems Incorporated, 345 Park Avenue, San Jose, CA 95110-2704, USA. 
For U.S. Government End Users, Adobe agrees to comply with all applicable equal 
opportunity laws including, if appropriate, the provisions of Executive Order 11246, 
as amended, Section 402 of the Vietnam Era Veterans Readjustment Assistance Act 
of 1974 (38 USC 4212), and Section 503 of the Rehabilitation Act of 1973, as 
amended, and the regulations at 41 CFR Parts 60-1 through 60-60, 60-250, and 
60-741. The affirmative action clause and regulations contained in the preceding 
sentence shall be incorporated by reference in this Agreement. 

13. Compliance with Licenses. If you are a business or organization, you agree that 
upon request from Adobe or Adobe’s authorized representative, you will within thirty 
(30) days fully document and certify that use of any and all Software at the time of the 
request is in conformity with your valid licenses from Adobe. 

14. Specific Provisions and Exceptions. 



14.1 Limited Warranty for Users Residing in Germany or Austria. If you obtained the 
Software in Germany or Austria, and you usually reside in such country, then Section 
7 does not apply, instead, Adobe warrants that the Software provides the 
functionalities set forth in the Documentation (the "agreed upon functionalities") for 
the limited warranty period following receipt of the Software when used on the 
recommended hardware configuration. As used in this Section, "limited warranty 
period" means one (1) year if you are a business user and two (2) years if you are not 
a business user. Non-substantial variation from the agreed upon functionalities shall 
not be considered and does not establish any warranty rights. THIS LIMITED 
WARRANTY DOES NOT APPLY TO SOFTWARE PROVIDED TO YOU FREE OF 
CHARGE, FOR EXAMPLE, UPDATES, PRE-RELEASE, TRYOUT, PRODUCT 
SAMPLER, NOT FOR RESALE (NFR) COPIES OF SOFTWARE, 

OR SOFTWARE THAT HAS BEEN ALTERED BY YOU, TO THE EXTENT SUCH 
ALTERATIONS CAUSED A DEFECT. To make a warranty claim, during the limited 
warranty period you must return, at our expense, the Software and proof of purchase 
to the location where you obtained it. If the functionalities of the Software vary 
substantially from the agreed upon functionalities, Adobe is entitled -- by way of 
re-performance and at its own discretion -- to repair or replace the Software. If this 
fails, you are entitled to a reduction of the purchase price (reduction) or to cancel the 
purchase agreement (rescission). For further warranty information, please contact 
Adobe’s Customer Support Department 

14.2 Limitation of Liability for Users Residing in Germany and Austria. 

14.2.1 If you obtained the Software in Germany or Austria, and you usually reside in 
such country, then Section 8 does not apply, Instead, subject to the provisions in 
Section 14.2.2, Adobe's statutory liability for damages shall be limited as follows: (i) 
Adobe shall be liable only up to the amount of damages as typically foreseeable at 
the time of entering into the purchase agreement in respect of damages caused by a 
slightly negligent breach of a material contractual obligation and (ii) Adobe shall not 
be liable for damages caused by a slightly negligent breach of a non-material 
contractual obligation. 

14.2.2 The aforesaid limitation of liability shall not apply to any mandatory statutory 
liability, in particular, to liability under the German Product Liability Act, liability for 
assuming a specific guarantee or liability for culpably caused personal injuries. 

14.2.3 You are required to take all reasonable measures to avoid and reduce 
damages, in particular to make back-up copies of the Software and your computer 
data subject to the provisions of this Agreement. 

14.3 Pre-release Product Additional Terms. If the product you have received with 
this license is pre-commercial release or beta Software ("Pre-release Software"), 
then the following Section applies. To the extent that any provision in this Section is 
in conflict with any other term or condition in this Agreement, this Section shall 
supercede such other term(s) and condition(s) with respect to the Pre-release 
Software, but only to the extent necessary to resolve the conflict. You acknowledge 
that the Software is a pre-release version, does not represent final product from 
Adobe, and may contain bugs, errors and other problems that could cause system or 
other failures and data loss. Consequently, the Pre-release Software is provided to 
you "AS-IS", and Adobe disclaims any warranty or liability obligations to you of any 
kind. WHERE LIABILITY CANNOT BE EXCLUDED FOR PRE-RELEASE 
SOFTWARE, BUT IT MAY BE LIMITED, ADOBE’S LIABILITY AND THAT OF ITS 
SUPPLIERS SHALL BE LIMITED TO THE SUM OF FIFTY DOLLARS (U.S. $50) IN 
TOTAL. You acknowledge that Adobe has not promised or guaranteed to you that 



Pre-release Software will be announced or made available to anyone in the future, 
Adobe has no express or implied obligation to you to announce or introduce the 
Pre-release Software and that Adobe may not introduce a product similar to or 
compatible with the Pre-release Software. Accordingly, you acknowledge that any 
research or development that you perform regarding the Pre-release Software or 
any product associated with the Pre-release Software is done entirely at your own 
risk. During the term of this Agreement, if requested by Adobe, you will provide 
feedback to Adobe regarding testing and use of the Pre-release Software, including 
error or bug reports. If you have been provided the Pre-release Software pursuant to 
a separate written agreement, such as the Adobe Systems Incorporated Serial 
Agreement for Unreleased Products, your use of the Software is also governed by 
such agreement. You agree that you may not and certify that you will not sublicense, 
lease, loan, rent, assign or transfer the Pre-release Software. Upon receipt of a later 
unreleased version of the Pre-release Software or release by Adobe of a publicly 
released commercial version of the Software, whether as a stand-alone product or 
as part of a larger product, you agree to return or destroy all earlier Pre-release 
Software received from Adobe and to abide by the terms of the license agreement 
for any such later versions of the Pre-release Software. Notwithstanding anything in 
this Section to the contrary, if you are located outside the United States of America, 
you agree that you will return or destroy all unreleased versions of the Pre-release 
Software within thirty (30) days of the completion of your testing of the Software 
when such date is earlier than the date for Adobe's first commercial shipment of the 
publicly released (commercial) Software. 

14.4 Settings Manager. Use of the Web Players, specifically the Flash Player, will 
enable the Software to store certain user settings as a local shared object on a your 
Computer. These settings are not associated with you, but allow you to configure 
certain settings within the Flash Player. You can find more information on local 
shared objects at 

http://www.adobe.com/software/flashplayer/security 

and more information on the Settings Manager at 

http://www.adobe.com/go/settingsmanager 

If you have any questions regarding this Agreement or if you wish to request any 
information from Adobe please use the address and contact information included 
with this product or via the web at www.adobe.com to contact the Adobe office 
serving your jurisdiction Adobe, Authorware, Flash, Reader, and Shockwave are 
either registered trademarks or trademarks of Adobe Systems Incorporated in the 
United States and/or other countries. 
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10.2 .Net Framework 

See http://msdn2.microsoft.com/en-us/netframework/aa569264.aspx

 

http://msdn2.microsoft.com/en-us/netframework/aa569264.aspx


10.3 PKWARE, Inc., Third-Party License Summary 
for PKZIP® and SecureZIP® for AIX, HP/UX, Solaris and 
Windows Server v8.6 

The PKWARE® PKZIP® and SecureZIP® for AIX, HP/UX, Solaris and Windows 
Server v8.6 product makes use of software modules or code developed by one or 
more third parties. This document identifies the licensing information governing this 
third-party software.  

PKWARE, the PKWARE Logo, PKZIP, SecureZIP and PKSFX are registered 
trademarks of PKWARE, Inc. Trademarks of other companies mentioned here 
appear for identification purposes only and are the property of their respective 
companies. 
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AES Decryption Routines by Dr. Brian Gladman 

Below are given the license and disclaimer for software written by Dr. Brian Gladman 
for implementing decryption for AES. 

 

Copyright (c) 2002, Dr Brian Gladman <brg@gladman.me.uk>, Worcester, UK. All 
rights reserved. 

LICENSE TERMS 

The free distribution and use of this software in both source and binary form is 
allowed (with or without changes) provided that: 

Distributions of this source code include the above copyright notice, this list of 
conditions and the following disclaimer; 

Distributions in binary form include the above copyright notice, this list of conditions 
and the following disclaimer in the documentation and/or other associated materials; 

The copyright holder's name is not used to endorse products built using this software 
without specific written permission. 

ALTERNATIVELY, provided that this notice is retained in full, this product may be 
distributed under the terms of the GNU General Public License (GPL), in which case 
the provisions of the GPL apply INSTEAD OF those given above. 

DISCLAIMER 

This software is provided 'as is' with no explicit or implied warranties in respect of its 
properties, including, but not limited to, correctness and/or fitness for purpose. 



 

 

OpenLDAP Public License 

The software includes portions that are copyrighted by the OpenLDAP Foundation, 
1998-2003, and are used under the OpenLDAP Public License.  

 

The OpenLDAP Public License 

  Version 2.7, 7 September 2001 

Redistribution and use of this software and associated documentation ("Software"), 
with or without modification, are permitted provided that the following conditions are 
met: 

1. Redistributions of source code must retain copyright statements and notices, 

2. Redistributions in binary form must reproduce applicable copyright statements 
and notices, this list of conditions, and the following disclaimer in the documentation 
and/or other materials provided with the distribution, and 

3. Redistributions must contain a verbatim copy of this document. 

The OpenLDAP Foundation may revise this license from time to time. Each revision 
is distinguished by a version number. You may use this Software under terms of this 
license revision or under the terms of any subsequent revision of the license. 

THIS SOFTWARE IS PROVIDED BY THE OPENLDAP FOUNDATION AND ITS 
CONTRIBUTORS "AS IS'' AND ANY EXPRESSED OR IMPLIED WARRANTIES, 
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE 
DISCLAIMED. IN NO EVENT SHALL THE OPENLDAP FOUNDATION, ITS 
CONTRIBUTORS, OR THE AUTHOR(S) OR OWNER(S) OF THE SOFTWARE BE 
LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, 
OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, 
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, 
DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND 
ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, 
OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY 
OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGE. 

The names of the authors and copyright holders must not be used in advertising or 
otherwise to promote the sale, use or other dealing in this Software without specific, 
written prior permission. Title to copyright in this Software shall at all times remain 
with copyright holders. 

OpenLDAP is a registered trademark of the OpenLDAP Foundation. 

Copyright 1999-2001 The OpenLDAP Foundation, Redwood City, California, USA. 
All Rights Reserved. Permission to copy and distribute verbatim copies of this 
document is granted. 

 

 

BZIP2 



Below are given the license and disclaimer for BZIP2. 

 

This program, "bzip2", the associated library "libbzip2", and all documentation, are 
copyright (C) 1996-2005 Julian R Seward. All rights reserved. 

Redistribution and use in source and binary forms, with or without modification, are 
permitted provided that the following conditions are met: 

1. Redistributions of source code must retain the above copyright notice, this list of 
conditions and the following disclaimer. 

2. The origin of this software must not be misrepresented; you must not claim that 
you wrote the original software. If you use this software in a product, an 
acknowledgment in the product documentation would be appreciated but is not 
required. 

3. Altered source versions must be plainly marked as such, and must not be 
misrepresented as being the original software. 

4. The name of the author may not be used to endorse or promote products derived 
from this software without specific prior written permission. 

THIS SOFTWARE IS PROVIDED BY THE AUTHOR "AS IS'' AND ANY EXPRESS 
OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED 
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR 
PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE AUTHOR BE LIABLE 
FOR ANY 

DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR 
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, 
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, 
DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND 
ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, 
OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY 
OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGE. 

 

 

CRC-32 

Below are given the license and disclaimer for CRC-32. 

 

/* crc32.c -- compute the CRC-32 of a data stream 

 * Copyright (C) 1995-2003 Mark Adler 

 * For conditions of distribution and use, see copyright notice in zlib.h 

 * 

 * Thanks to Rodney Brown <rbrown64@csc.com.au> for his contribution of faster 

 * CRC methods: exclusive-oring 32 bits of data at a time, and pre-computing 

 * tables for updating the shift register in one step with three exclusive-ors 

 * instead of four steps with four exclusive-ors. This results about a factor 



 * of two increase in speed on a Power PC G4 (PPC7455) using gcc -O3. 

 */ 

 

/* zlib.h -- interface of the 'zlib' general purpose compression library 

  version 1.1.3, July 9th, 1998 

 

  Copyright (C) 1995-1998 Jean-loup Gailly and Mark Adler 

 

This software is provided 'as-is', without any express or implied warranty. In no event 
will the authors be held liable for any damages arising from the use of this software. 

 

Permission is granted to anyone to use this software for any purpose, including 
commercial applications, and to alter it and redistribute it freely, subject to the 
following restrictions: 

1. The origin of this software must not be misrepresented; you must not claim that 
you wrote the original software. If you use this software in a product, an 
acknowledgment in the product documentation would be appreciated but is not 
required. 

2. Altered source versions must be plainly marked as such, and must not be 
misrepresented as being the original software. 

3. This notice may not be removed or altered from any source distribution. 

 

  Jean-loup Gailly        Mark Adler 

  jloup@gzip.org          madler@alumni.caltech.edu 

 

The data format used by the zlib library is described by RFCs (Request for 
Comments) 1950 to 1952 in the files ftp://ds.internic.net/rfc/rfc1950.txt (zlib format), 
rfc1951.txt (deflate format) and rfc1952.txt (gzip format). 

*/ 

 

 

Net-SNMP 

Below are given the license and disclaimer for Net-SNMP. 

 

Various copyrights apply to this package, listed in various separate parts below. 
Please make sure that you read all the parts. Up until 2001, the project was based at 
UC Davis, and the first part covers all code written during this time. From 2001 
onwards, the project has been based at SourceForge, and Networks Associates 
Technology, Inc hold the copyright on behalf of the wider Net-SNMP community, 
covering all derivative work done since then. An additional copyright section has 



been added as Part 3 below also under a BSD license for the work contributed by 
Cambridge Broadband Ltd. to the project since 2001. 

An additional copyright section has been added as Part 4 below also under a BSD 
license for the work contributed by Sun Microsystems, Inc. to the project since 2003. 

Code has been contributed to this project by many people over the years it has been 
in development, and a full list of contributors can be found in the README file under 
the THANKS section. 

 

---- Part 1: CMU/UCD copyright notice: (BSD like) ----- 

 

       Copyright 1989, 1991, 1992 by Carnegie Mellon University 

 

    Derivative Work - 1996, 1998-2000 

Copyright 1996, 1998-2000 The Regents of the University of California 

 

    All Rights Reserved 

 

Permission to use, copy, modify and distribute this software and its documentation 
for any purpose and without fee is hereby granted, provided that the above copyright 
notice appears in all copies and that both that copyright notice and this permission 
notice appear in supporting documentation, and that the name of CMU and The 
Regents of the University of California not be used in advertising or publicity 
pertaining to distribution of the software without specific written permission. 

 

CMU AND THE REGENTS OF THE UNIVERSITY OF CALIFORNIA DISCLAIM ALL 
WARRANTIES WITH REGARD TO THIS SOFTWARE, INCLUDING ALL IMPLIED 
WARRANTIES OF MERCHANTABILITY AND FITNESS. IN NO EVENT SHALL 
CMU OR THE REGENTS OF THE UNIVERSITY OF CALIFORNIA BE LIABLE FOR 
ANY SPECIAL, INDIRECT OR CONSEQUENTIAL DAMAGES OR ANY DAMAGES 
WHATSOEVER RESULTING FROM THE LOSS OF USE, DATA OR PROFITS, 
WHETHER IN AN ACTION OF CONTRACT, NEGLIGENCE OR OTHER 
TORTIOUS ACTION, ARISING OUT OF OR IN CONNECTION WITH THE USE OR 
PERFORMANCE OF THIS SOFTWARE. 

 

---- Part 2: Networks Associates Technology, Inc copyright notice (BSD) ----- 

 

Copyright (c) 2001-2003, Networks Associates Technology, Inc 

All rights reserved. 

  

Redistribution and use in source and binary forms, with or withoutmodification, are 
permitted provided that the following conditions are met: 



*  Redistributions of source code must retain the above copyright notice, this list of 
conditions and the following disclaimer. 

*  Redistributions in binary form must reproduce the above copyright notice, this list 
of conditions and the following disclaimer in the documentation and/or other 
materials provided with the distribution. 

*  Neither the name of the Networks Associates Technology, Inc nor the names of its 
contributors may be used to endorse or promote products derived from this software 
without specific prior written permission. 

  

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND 
CONTRIBUTORS "AS IS'' AND ANY EXPRESS OR IMPLIED WARRANTIES, 
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE 
DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDERS OR 
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, 
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT 
NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; 
LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) 
HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN 
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR 
OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, 
EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE. 

 

---- Part 3: Cambridge Broadband Ltd. copyright notice (BSD) ----- 

 

Portions of this code are copyright (c) 2001-2003, Cambridge Broadband Ltd. 

All rights reserved. 

  

Redistribution and use in source and binary forms, with or without modification, are 
permitted provided that the following conditions are met: 

*  Redistributions of source code must retain the above copyright notice, this list of 
conditions and the following disclaimer. 

*  Redistributions in binary form must reproduce the above copyright notice, this list 
of conditions and the following disclaimer in the documentation and/or other 
materials provided with the distribution. 

*  The name of Cambridge Broadband Ltd. may not be used to endorse or promote 
products derived from this software without specific prior written permission. 

  

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDER "AS IS'' AND 
ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, 
THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A 
PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE 
COPYRIGHT HOLDER BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, 
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT 
NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; 



LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) 
HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN 
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR 
OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, 
EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE. 

 

---- Part 4: Sun Microsystems, Inc. copyright notice (BSD) ----- 

 

Copyright © 2003 Sun Microsystems, Inc., 4150 Network Circle, Santa Clara,  

California 95054, U.S.A. All rights reserved. 

 

Use is subject to license terms below. 

 

This distribution may include materials developed by third parties. 

 

Sun, Sun Microsystems, the Sun logo and Solaris are trademarks or registered 
trademarks of Sun Microsystems, Inc. in the U.S. and other countries. 

 



Redistribution and use in source and binary forms, with or without 

modification, are permitted provided that the following conditions are met: 

*  Redistributions of source code must retain the above copyright notice, this list of 
conditions and the following disclaimer. 

*  Redistributions in binary form must reproduce the above copyright notice, this list 
of conditions and the following disclaimer in the documentation and/or other 
materials provided with the distribution. 

*  Neither the name of the Sun Microsystems, Inc. nor the names of its contributors 
may be used to endorse or promote products derived from this software without 
specific prior written permission. 

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND 
CONTRIBUTORS "AS IS'' AND ANY EXPRESS OR IMPLIED WARRANTIES, 
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE 
DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDERS OR 
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, 
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT 
NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; 
LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) 
HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN 
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR 
OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, 
EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE. 

 

---- Part 5: Sparta, Inc copyright notice (BSD) ----- 

 

Copyright (c) 2003-2005, Sparta, Inc 

All rights reserved. 

  

Redistribution and use in source and binary forms, with or without modification, are 
permitted provided that the following conditions are met: 

*  Redistributions of source code must retain the above copyright notice, this list of 
conditions and the following disclaimer. 

*  Redistributions in binary form must reproduce the above copyright notice, this list 
of conditions and the following disclaimer in the documentation and/or other 
materials provided with the distribution. 

*  Neither the name of Sparta, Inc nor the names of its contributors may be used to 
endorse or promote products derived from this software without specific prior written 
permission. 

 THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND 
CONTRIBUTORS "AS IS'' AND ANY EXPRESS OR IMPLIED WARRANTIES, 
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE 
DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDERS OR 



CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, 
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT 
NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; 
LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) 
HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN 
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR 
OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, 
EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE. 

 

---- Part 6: Cisco/BUPTNIC copyright notice (BSD) ----- 

 

Copyright (c) 2004, Cisco, Inc and Information Network 

Center of Beijing University of Posts and Telecommunications. 

All rights reserved. 

  

Redistribution and use in source and binary forms, with or without modification, are 
permitted provided that the following conditions are met: 

*  Redistributions of source code must retain the above copyright notice, this list of 
conditions and the following disclaimer. 

*  Redistributions in binary form must reproduce the above copyright notice, this list 
of conditions and the following disclaimer in the documentation and/or other 
materials provided with the distribution. 

*  Neither the name of Cisco, Inc, Beijing University of Posts and 
Telecommunications, nor the names of their contributors may be used to endorse or 
promote products derived from this software without specific prior written 
permission. 

 THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND 
CONTRIBUTORS "AS IS'' AND ANY EXPRESS OR IMPLIED WARRANTIES, 
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE 
DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT HOLDERS OR 
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, 
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT 
NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; 
LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) 
HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN 
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR 
OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, 
EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE. 

 

---- Part 7: Fabasoft R&D Software GmbH & Co KG copyright notice (BSD) ----- 

 

Copyright (c) Fabasoft R&D Software GmbH & Co KG, 2003 

oss@fabasoft.com 



Author: Bernhard Penz <bernhard.penz@fabasoft.com> 

 

Redistribution and use in source and binary forms, with or without modification, are 
permitted provided that the following conditions are met: 

*  Redistributions of source code must retain the above copyright notice, this list of 
conditions and the following disclaimer. 

*  Redistributions in binary form must reproduce the above copyright notice, this list 
of conditions and the following disclaimer in the documentation and/or other 
materials provided with the distribution. 

*  The name of Fabasoft R&D Software GmbH & Co KG or any of its subsidiaries, 
brand or product names may not be used to endorse or promote products derived 
from this software without specific prior written permission. 

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDER "AS IS'' AND 
ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, 
THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A 
PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE 
COPYRIGHT HOLDER BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, 
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT 
NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; 
LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) 
HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN 
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR 
OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, 
EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE. 

 

 

10.4 License Conditions and Disclaimers for Open Source 
Software  

The product "STEP 7 V5.4 SP3" (hereafter referred to as "Product"), contains the 
open source software listed below in unmodified or in a form modified by us 
(hereinafter referred to as "Open Source Software"): 

 
Name License 

Xerces-C Apache license (see license text 1) 
Boost Regex boost license (see license text 2) 
zlib zlib license (see license text 3) 

 

The Open Source Software is provided free of charge. You are entitled to use the 
Open Source Software in accordance with the respective license conditions (OSS 
License Conditions) listed below. If there are inconsistencies between the OSS 
License Conditions and the license conditions of the Product as per clauses 2 and 3 
above, the OSS License Conditions shall prevail. In case of an infringement or 
breach of such OSS License Conditions the respective licensor named in such OSS 



License Conditions is entitled - in addition to ourselves - to bring forward and enforce 
the respective claims resulting from such infringement or breach in its own name. 

Insofar as the applicable OSS License Conditions provide for it you can order the 
source code of the Open Source Software from your Siemens sales contact - against 
payment of the shipping and handling charges - for a period of at least 3 years since 
purchase of the Product. 

Liability for Open Source Software  

We are liable for the Product including the Open Source Software contained in it 
pursuant to the license conditions applicable to the Product. Any liability for the Open 
Source Software beyond the program flow intended for the Product is explicitly 
excluded. Furthermore any liability for defects resulting from modifications to the 
Open Source Software by you or third parties is excluded. 

We do not provide any technical support for the Product if it has been modified.  

PLEASE READ THE BELOW LICENSE CONDITIONS CAREFULLY BEFORE 
USING THE PRODUCT. THE ACCEPTANCE OF ANY DISCLAIMER OF 
WARRANTY OR LIABILITY CONTAINED IN SUCH LICENSE CONDITIONS IS A 
STRICT PRECONDITION FOR THE USE OF THE OPEN SOURCE SOFTWARE. 

 

10.4.1 Licensing conditions for Xerxes-C 

See: http://xml.apache.org/xerces-c/ 

The Xerces-C++ Version 2.7.0 is available in both source distribution and binary 
distribution. Xerces-C++ is made available under the Apache Software License, 2.0 

Apache License 
Version 2.0, January 2004 
http://www.apache.org/licenses/  

TERMS AND CONDITIONS FOR USE, REPRODUCTION, AND DISTRIBUTION  

1. Definitions. 

"License" shall mean the terms and conditions for use, reproduction, and distribution 
as defined by Sections 1 through 9 of this document.  

"Licensor" shall mean the copyright owner or entity authorized by the copyright 
owner that is granting the License.  

"Legal Entity" shall mean the union of the acting entity and all other entities that 
control, are controlled by, or are under common control with that entity. For the 
purposes of this definition, "control" means (i) the power, direct or indirect, to cause 
the direction or management of such entity, whether by contract or otherwise, or (ii) 
ownership of fifty percent (50%) or more of the outstanding shares, or (iii) beneficial 
ownership of such entity.  

"You" (or "Your") shall mean an individual or Legal Entity exercising permissions 
granted by this License.  

"Source" form shall mean the preferred form for making modifications, including but 
not limited to software source code, documentation source, and configuration files.  

http://www.apache.org/licenses/


"Object" form shall mean any form resulting from mechanical transformation or 
translation of a Source form, including but not limited to compiled object code, 
generated documentation, and conversions to other media types.  

"Work" shall mean the work of authorship, whether in Source or Object form, made 
available under the License, as indicated by a copyright notice that is included in or 
attached to the work (an example is provided in the Appendix below).  

"Derivative Works" shall mean any work, whether in Source or Object form, that is 
based on (or derived from) the Work and for which the editorial revisions, 
annotations, elaborations, or other modifications represent, as a whole, an original 
work of authorship. For the purposes of this License, Derivative Works shall not 
include works that remain separable from, or merely link (or bind by name) to the 
interfaces of, the Work and Derivative Works thereof.  

"Contribution" shall mean any work of authorship, including the original version of the 
Work and any modifications or additions to that Work or Derivative Works thereof, 
that is intentionally submitted to Licensor for inclusion in the Work by the copyright 
owner or by an individual or Legal Entity authorized to submit on behalf of the 
copyright owner. For the purposes of this definition, "submitted" means any form of 
electronic, verbal, or written communication sent to the Licensor or its 
representatives, including but not limited to communication on electronic mailing 
lists, source code control systems, and issue tracking systems that are managed by, 
or on behalf of, the Licensor for the purpose of discussing and improving the Work, 
but excluding communication that is conspicuously marked or otherwise designated 
in writing by the copyright owner as "Not a Contribution."  

"Contributor" shall mean Licensor and any individual or Legal Entity on behalf of 
whom a Contribution has been received by Licensor and subsequently incorporated 
within the Work.  

2. Grant of Copyright License. Subject to the terms and conditions of this License, 
each Contributor hereby grants to You a perpetual, worldwide, non-exclusive, 
no-charge, royalty-free, irrevocable copyright license to reproduce, prepare 
Derivative Works of, publicly display, publicly perform, sublicense, and distribute the 
Work and such Derivative Works in Source or Object form.  

3. Grant of Patent License. Subject to the terms and conditions of this License, 
each Contributor hereby grants to You a perpetual, worldwide, non-exclusive, 
no-charge, royalty-free, irrevocable (except as stated in this section) patent license 
to make, have made, use, offer to sell, sell, import, and otherwise transfer the Work, 
where such license applies only to those patent claims licensable by such 
Contributor that are necessarily infringed by their Contribution(s) alone or by 
combination of their Contribution(s) with the Work to which such Contribution(s) was 
submitted. If You institute patent litigation against any entity (including a cross-claim 
or counterclaim in a lawsuit) alleging that the Work or a Contribution incorporated 
within the Work constitutes direct or contributory patent infringement, then any 
patent licenses granted to You under this License for that Work shall terminate as of 
the date such litigation is filed.  

4. Redistribution. You may reproduce and distribute copies of the Work or 
Derivative Works thereof in any medium, with or without modifications, and in Source 
or Object form, provided that You meet the following conditions:  

You must give any other recipients of the Work or Derivative Works a copy of this 
License; and  



You must cause any modified files to carry prominent notices stating that You 
changed the files; and  

You must retain, in the Source form of any Derivative Works that You distribute, all 
copyright, patent, trademark, and attribution notices from the Source form of the 
Work, excluding those notices that do not pertain to any part of the Derivative Works; 
and  

If the Work includes a "NOTICE" text file as part of its distribution, then any 
Derivative Works that You distribute must include a readable copy of the attribution 
notices contained within such NOTICE file, excluding those notices that do not 
pertain to any part of the Derivative Works, in at least one of the following places: 
within a NOTICE text file distributed as part of the Derivative Works; within the 
Source form or documentation, if provided along with the Derivative Works; or, within 
a display generated by the Derivative Works, if and wherever such third-party 
notices normally appear. The contents of the NOTICE file are for informational 
purposes only and do not modify the License. You may add Your own attribution 
notices within Derivative Works that You distribute, alongside or as an addendum to 
the NOTICE text from the Work, provided that such additional attribution notices 
cannot be construed as modifying the License. 

You may add Your own copyright statement to Your modifications and may provide 
additional or different license terms and conditions for use, reproduction, or 
distribution of Your modifications, or for any such Derivative Works as a whole, 
provided Your use, reproduction, and distribution of the Work otherwise complies 
with the conditions stated in this License.  

5. Submission of Contributions. Unless You explicitly state otherwise, any 
Contribution intentionally submitted for inclusion in the Work by You to the Licensor 
shall be under the terms and conditions of this License, without any additional terms 
or conditions. Notwithstanding the above, nothing herein shall supersede or modify 
the terms of any separate license agreement you may have executed with Licensor 
regarding such Contributions.  

6. Trademarks. This License does not grant permission to use the trade names, 
trademarks, service marks, or product names of the Licensor, except as required for 
reasonable and customary use in describing the origin of the Work and reproducing 
the content of the NOTICE file.  

7. Disclaimer of Warranty. Unless required by applicable law or agreed to in 
writing, Licensor provides the Work (and each Contributor provides its Contributions) 
on an "AS IS" BASIS, WITHOUT WARRANTIES OR CONDITIONS OF ANY KIND, 
either express or implied, including, without limitation, any warranties or conditions of 
TITLE, NON-INFRINGEMENT, MERCHANTABILITY, or FITNESS FOR A 
PARTICULAR PURPOSE. You are solely responsible for determining the 
appropriateness of using or redistributing the Work and assume any risks associated 
with Your exercise of permissions under this License.  

8. Limitation of Liability. In no event and under no legal theory, whether in tort 
(including negligence), contract, or otherwise, unless required by applicable law 
(such as deliberate and grossly negligent acts) or agreed to in writing, shall any 
Contributor be liable to You for damages, including any direct, indirect, special, 
incidental, or consequential damages of any character arising as a result of this 
License or out of the use or inability to use the Work (including but not limited to 
damages for loss of goodwill, work stoppage, computer failure or malfunction, or any 



and all other commercial damages or losses), even if such Contributor has been 
advised of the possibility of such damages.  

9. Accepting Warranty or Additional Liability. While redistributing the Work or 
Derivative Works thereof, You may choose to offer, and charge a fee for, acceptance 
of support, warranty, indemnity, or other liability obligations and/or rights consistent 
with this License. However, in accepting such obligations, You may act only on Your 
own behalf and on Your sole responsibility, not on behalf of any other Contributor, 
and only if You agree to indemnify, defend, and hold each Contributor harmless for 
any liability incurred by, or claims asserted against, such Contributor by reason of 
your accepting any such warranty or additional liability.  

END OF TERMS AND CONDITIONS  

 

10.4.2 Licensing conditions von Boost Regex 

see: http://www.boost.org/libs/regex 

_ Copyright John Maddock 1998-2004  

Use, modification and distribution are subject to the Boost Software License, Version 
1.0.  

Boost Software License - Version 1.0 - August 17th, 2003 

Permission is hereby granted, free of charge, to any person or organization obtaining 
a copy of the software and accompanying documentation covered by this license 
(the "Software") to use, reproduce, display, distribute, execute, and transmit the 
Software, and to prepare derivative works of the Software, and to permit third-parties 
to whom the Software is furnished to do so, all subject to the following: 

The copyright notices in the Software and this entire statement, including the above 
license grant, this restriction and the following disclaimer, must be included in all 
copies of the Software, in whole or in part, and all derivative works of the Software, 
unless such copies or derivative works are solely in the form of machine-executable 
object code generated by a source language processor. 

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, 
EXPRESS OR 

IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF 
MERCHANTABILITY, 

FITNESS FOR A PARTICULAR PURPOSE, TITLE AND NON-INFRINGEMENT. IN 
NO EVENT 

SHALL THE COPYRIGHT HOLDERS OR ANYONE DISTRIBUTING THE 
SOFTWARE BE LIABLE FOR ANY DAMAGES OR OTHER LIABILITY, WHETHER 
IN CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN 
CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN 
THE SOFTWARE. 



10.4.3 Licensing conditions von zlib 

/* zlib.h -- interface of the 'zlib' general purpose compression library version 1.2.3, 
July 18th, 2005 

Copyright (C) 1995-2005 Jean-loup Gailly and Mark Adler 

This software is provided 'as-is', without any express or implied warranty. In no event 
will the authors be held liable for any damages arising from the use of this software. 

Permission is granted to anyone to use this software for any purpose, including 
commercial applications, and to alter it and redistribute it freely, subject to the 
following restrictions: 

1. The origin of this software must not be misrepresented; you must not claim that 
you wrote the original software. If you use this software in a product, an 
acknowledgment in the product documentation would be appreciated but is not 
required. 

2. Altered source versions must be plainly marked as such, and must not be 
misrepresented as being the original software. 

3. This notice may not be removed or altered from any source distribution. 

Jean-loup Gailly jloup@gzip.org 

Mark Adler madler@alumni.caltech.edu 

*/ 
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